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The IP PBX datasheet contains a comprehensive list of features 
and their detailed description, as well as the comparison of 
business, call center, and multi-tenant editions of IP PBX.



WORLD’S FIRST AND MOST MATURE IP PBX
dedicated to hosting telephony & unified communications in the cloud.



IP PBX EDITIONS

IP PBX is the world’s first and most mature IP PBX Professional Open Standards Turnkey Telephony Platform. Since 2004, IP PBX has deployed 
flexible, reliable, and scalable New Generation Communication Systems to SMBs, enterprises, and governments worldwide by unifying the most 
advanced of the latest technologies. IP PBX is offered in the Business, Contact Center and Multi-Tenant Editions, each supporting specific features 
maximizing performance, reliability, and expandability.

MULTI-TENANT EDITION
The Multi-Tenant Edition of IP PBX gives Telecom Service Providers a powerful platform to serve the IP PBX market in the cloud as a VoIP switch. 
Unlimited Hosted IP PBX Multi-Tenants, Unlimited resellers, user/company self-portal, and LCR are just a few of the advanced features included with 
desktop applications.

BUSINESS EDITION
IP PBX Business edition is our extensive and fully customizable platform providing you with a comprehensive set of features and capabilities of the 
enterprise phone system. Transform the way you conduct business and increase efficiency in the workplace by truly unifying your communication 
system. As you grow, so does your phone system!

CONTACT CENTER EDITION
IP PBX Contact Center edition is designed to simplify and enhance call management at the busy call centers of any size. Give your business all the 
tools it needs to effectively start and manage inbound or outbound call campaigns. Upgrade to IP PBX Contact Center, and provide your customers 
with a consistent and quality experience.
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SYSTEM DASHBOARD
Multi-Tenant Business Contact Center

System Dashboard
The Dashboard section gives you an overview of vital IP PBX information. It displays hardware 
usage, main services status, information on the system and Communicator licensing as well as the 
number of Total calls, Answered calls, SIP registration etc.
Number of Provisioned Extensions on the Dashboard
Presents information on how many extensions have been provisioned/added to the system.

SYSTEM EXTENSIONS
Multi-Tenant Business Contact Center

Protocols: SIP, IAX2, DAHDI
IP PBX extensions support SIP and IAX2 protocols as well as DAHDI interface technology. SIP and 
IAX2 are communications protocols used for signaling and controlling multimedia communication 
sessions while DAHDI is an open-source computer telephony hardware driver API.
Outbound Destinations Permissions
Administrators have full control over which destinations, local or remote, IP PBX extensions can 
dial. These rules can be applied to multiple extensions at the same time (through Service Plans) or 
individually per extension.
Multiple Registrations
IP PBX 6 does not have restrictions in regards to the number of registered devices, regardless of 
device type.
Multiple MAC Addresses per One Extension
We have added the ability to use multiple MAC addresses per single extension. This provides the 
ability to auto-provision multiple phones attached to the same Extension. In practice, this could be 
one type of device, or multiple types of devices linked to the same extension. This is similar to our 
Hot Desking feature.



Multi-Tenant Business Contact Center
Push Notifications
IP PBX 5 is now running push notification service that propagates push notifications to devices that 
are registered to a IP PBX extension with Communicator GO. This feature increases user connectivity 
and flexibility for business trips, working from home, or any other calls made outside of the office.
Enhanced Services
Enhanced Services allows IP PBX Administrators, as well as end users, to set up and control 
extensions features like Caller ID, Call Pickup, Call Filters & Blocking, Call Forwarding etc. from their 
phone and through a web interface.
Billing
IP PBX billing module is one of the most important system components. It allows you to set up 
outbound and inbound billing prices for all the destinations across the globe. When Time Based 
Dialing (TBD) rules are used, the system allows you to create different prices for the specific day/
time ranges.
LCR
IP PBX LCR (Least Cost Routing) section allows fine-tuning of the system’s trunks usage, enabling 
administrator to set up the order in which trunks will be used in order to strike the perfect balance 
between price and call quality.
Caller ID Control
IP PBX allows you complete control of your Caller ID for outbound calls. Please note that this 
feature will also depend on Caller ID rules enforced by your trunk provider.
Codec Selection
IP PBX allows you to set the preferred order in which codecs will be used on system, tenant or 
extension level. This option will allow you to assign more than one codec and set them to be used 
under a specific priority.
Auto Provisioning
Auto-provisioning allows you to automatically configure your phones by pointing them to a IP PBX 
tftp/http address. To utilize the auto-provisioning system you must use one of the desk phone 
devices from the evergrowing IP PBX list of supported UADs and configure a IP PBX extension with 
a matching UAD and MAC address.



Multi-Tenant Business Contact Center
Auto provisioning, additional config customization variables
Additional config for Auto Provisioning on the following pages can now use template 
variables: 
Extensions > Edit > UAD Auto Provisioning Template 
Settings > UAD > Edit > User Agent General Auto Provisioning Template 
Settings > UAD > Edit > User Agent Auto Provisioning Template 
 
The following variables can be used: 
%TENANT_CODE% - tenant code 
%EXT_NUMBER% - extension number 
%EXT_NAME% - extension name 
%MAC_ADDRESS% - extension MAC address (the mac from the auto provisioning request) 
%WAN_IP% - WAN Hostname/IP set in Servers > Edit 
%LAN_IP% - LAN Hostname/IP set in Servers > Edit 
%AUTH_USERNAME% - HTTP username 
%AUTH_PASSWORD% - HTTP username 
%VM_PIN% - extension voicemail PIN
Line Number
When auto-provisioning multiple extensions on 1 phone, extensions are assigned to the lines in 
the order in which they were created in IP PBX. The line field will allow customers to specify the 
extension line where this extension will be assigned on the device. An empty line number field will 
be treated as the last one.
Voicemail
IP PBX voicemail is an advanced answering machine that allows callers to leave a voicemail message 
in scenarios where the callee is not able to answer the call. Although each IP PBX extension is usually 
equipped with a voice mailbox, this feature can be turned off, and, if necessary, voice mailboxes can 
be created on their own, unrelated to any extension on your IP PBX.
Call Recording
IP PBX offers multiple options to enable call recording, defining whether you would like to inform all 
parties that a call recording is turned on or not. Call recording can be enabled globally, for the entire 
system, or lower level per Tenant, DID, Extension, Ring group etc.



Multi-Tenant Business Contact Center
Call Recordings: Listen to Recordings in Web Browser
The new IP PBX 5 interface now has an integrated call recordings player, allowing users to listen to 
IP PBX call recordings directly from their browser and navigate through the recording with a simple 
click of a mouse. This prevents the issue users might have experienced with earlier versions, as they 
had to find a media player that supports the format in which recordings were being downloaded.
CSV Upload
CSV upload allows you to easily create multiple entries for different IP PBX elements like Extensions 
and DIDs, or to quickly add or change prices for every destination in the service plan. 

CSV Download
CSV download gives you an option to export IP PBX data in CSV format, allowing you to get 
information for data processing (i.e. DID or Extension list), or for importing data to another IP PBX 
(i.e. billing prices for different destinations).
Departments
Departments section lists all of the departments created on your IP PBX and gives you the ability 
to add new ones or edit existing. Departments are used by Communicator to easily filter extensions 
per department or to broadcast messages to specific department members only.
Communicator Modules and Editions
Communicator Editions and Modules allow you to restrict extensions to only use selected 
Communicator editions and modules. This prevents users from switching their Communicator 
edition, for sheer curiosity, to one that they should not be using. When a user does this, it prevents 
extensions that are actually supposed to use that particular edition from using it.
Communicator Features Administration
We have introduced the ability for an administrator to enable/disable Communicator features 
globally per system, per edition or per Tenant.

QR Code
QR Code allows for an easy first-time login with the Communicator GO mobile app. Instead of 
entering an e-mail, password and server address manually on the first login, all you have to do is to 
scan the QR Code from your mobile app and all the information will be entered automatically.
Desktop Apps Integration
IP PBX offers seamless integration with the Communicator desktop app, allowing users to save time 
and improve productivity.



Multi-Tenant Business Contact Center
Mobile Apps Integration
Communicator GO mobile app allows you to stay connected to your IP PBX extension even when 
you are not in your office, enabling you to do your work without being confined to your desk.
WebRTC Support
IP PBX now supports WebRTC. WebRTC provides browsers and mobile applications with Real-Time 
Communications capabilities via simple APIs.
PIN Based Devices
Every extension is now allocated in its own unique PBD PIN. This PIN will identify the user on the 
system and, when logged in to a PIN Based Device, dialing will proceed as though the user was 
calling from their own extension. Billing, CDRs and all other functions will be completed on the user 
extension and not the extension associated with the Pin Based Device.
Copy Extension
A new feature in IP PBX 5.1 is “Copy As New”, an option to create a new extension by making copies 
of an existing extension’s settings. This will speed up the process of adding new extensions to the 
system.
Operation Times per Extension
We have introduced an “Operation Times” option for extensions allowing you to control work days 
and hours per extension by simply adjusting this feature in enhanced services. This is also available 
in OSC if enabled in Enhanced Services. We have also implemented UX improvements and GUI 
improvements in the Global Operations Times page for a better user experience.
Area Code per Extension
Area code implemented per extension so you can define the area code which will be dialed if a 
specific extension makes a call without the need to dial the initial area code.
Ability to Block Incoming Calls
Ability to block incoming calls while having another active call. This will be used by the users who do 
not wish to receive incoming calls if they are already on a call (either incoming or outgoing).
Show on the Monitor Page
Excludes an extension from showing on the Monitor page. Useful for virtual extensions that will 
never be online in order to get a more accurate count of phones online.
Ability to control default location mode when adding extensions
When creating a new extension you can choose which default location will be selected.



Multi-Tenant Business Contact Center
Support for PAI variable per extension
Define what will be inserted into the trunk PAI header template.
Caller ID/E911 summary
A list of all extensions and assigned Caller IDs and Emergency Caller IDs.
Operator Extension
During the initial Setup Wizard, on the Business/Call Center edition, the Operator Extension will 
be assigned to the extension that is created automatically once the Setup Wizard is completed (i.e. 
extension 1000) but can later be changed to any other extension on your system. The Operator 
extension is a central location where all the calls will be routed if a call is passed through the trunk to 
the IP PBX but its destination is wrong or does not exist. In the rare occurrence this might happen, is 
when you purchase a range of DIDs from your provider, but do not create a matching DID on your 
IP PBX. In this scenario, your provider will forward the call to your system but because the DID does 
not exist, the call will be forwarded to the Operator Extension instead of being dropped by IP PBX.
Add emergency trunk per extension option
Ability to set emergency trunks per extension.



BILLING
IP PBX billing module is a vital tool that provides easy management of service plans, extension funds, and allows full control over pricing and billing for outbound 
and inbound calls.

Multi-Tenant Business Contact Center
Service Plan
Service plan defines billing details for all available destinations but it will also enable you to create 
a template for IP PBX Enhanced Services, Destinations permissions and Online Self Care settings 
which all will be automatically applied to every extension associated with a particular service plan.
Master / Slave Accounts
Depending on your preferences, an extension can have its own funds (master) or share funds with 
master extensions (slave). Setting one extension as “master” and rest of the extensions as “slave” can 
be very useful and would improve billing management as with this setup you will have a single point 
for managing funds and billing, instead of doing it for each of the extensions individually.
Credit Limits
Credit limits allow you to assign the maximum amount of funds extensions will be able to spend on 
calls, preventing users from having unlimited funds at their disposal.

Soft and Hard Daily / Monthly Billing Limits
Once a Soft Limit is reached on an extension, IP PBX will send an email notification to the user, 
informing him that extension funds are getting low. When the Hard Limit is reached IP PBX will 
block all outbound calls for this extension. Soft and Hard Limit can be set on a daily or monthly basis. 
Setting these two values will prevent users from having unlimited funds at their disposal.
Inclusive Minutes
Assigning a certain number of inclusive minutes to a service plan will allow users to make calls to 
destinations set up to use inclusive minutes, free of charge until all inclusive minutes are spent. At 
that point, the extension will start using available funds. Destinations that are not set up to use 
inclusive minutes will be charged according to the price set in the service plan.



OUTBOUND DESTINATIONS PERMISSIONS
Multi-Tenant Business Contact Center

Destination Groups
Permissions per destination groups enable you to restrict dialing to specific domestic or international 
destinations, or to all international destinations if necessary. This feature can be set on the service 
plan level or set and modified per extension.
Local Destinations
In addition to permissions per destination group IP PBX allows you to restrict calls to local destinations 
such as local extensions, auto attendants, conferences, queues etc. This feature can be set on the 
service plan level or set and modified per extension.
Other Networks
Other Networks feature allows the administrator to assign a specific prefix to some of the IP PBX trunks. 
This will allow users to dial the assigned prefix in order to force the call to be made through a specific trunk.  
NOTE: Please be aware that when Other Networks features are used, the billing module will be overridden 
and calls made this way would not be billed.
Special Routes
Special Routes feature allows the IP PBX administrator to add special service numbers that will be 
distinguished from extension numbers (even if they have the same number of digits) and dialed 
through the specified trunk, similar to how Emergency Services numbers are dialed through an 
Emergency Trunk.

ENHANCED SERVICES
Multi-Tenant Business Contact Center

Caller ID
Caller ID feature allows users to create and control the caller ID number that will be displayed to 
the called party. In addition to setting the permanent call that will be used as primary Caller ID, the 
administrator can create a list of allowed caller IDs that can be selected before the call is initiated. 
This feature is intended to be used with the Communicator desktop app but it can also be used by 
entering an access code on the desk phone.



Multi-Tenant Business Contact Center
Call Pickup
Call Pickup feature enables users to pick up calls that are ringing other extensions in associated 
call groups. Along with call pickup enabling you to pick calls that are ringing any extension in your 
call group by simply dialing *8, it is possible to use directed pickup and pick up calls from a specific 
extension by dialing *88 + EXTENSION.
Last Caller
Last Caller allows users to dial the last number that dialed their number by entering an access code. 
This is basically a redial feature intended to be used on phones without a display screen or analog 
phones that are registering to IP PBX through ATA devices.
Call Filters & Blocking
Based on a set of predefined rules this service filters and blocks all incoming calls based on the rules 
you have set for incoming caller IDs. This way, you are able to send a busy signal to all calls that have 
their caller ID hidden, or forward the call to an out of service number whenever a specific number 
dials your extension.
Do Not Disturb
When enabled the Do Not Disturb service can block and temporarily or permanently redirect all 
incoming calls to a preferred destination number.
Call Screening
Call screening enables a user to forward calls to other extensions depending on the user’s extension 
status.
Call Forwarding
Call Forwarding service forwards calls to other destinations depending on the rules created for a 
particular extensions status. For example, you can forward calls to your cell phone in case you do 
not answer the call in 15 seconds or in case your extension becomes unavailable for some reason.
Configure Call Forwarding for Internal and External Calls Separately
Check the “Different Rules for Local calls” box on the Call forwarding section. Checking this box will 
show a table where you can define different rules for Local Calls.
Whitelist Caller IDs that won’t be Forwarded
An Exclude list has been added where you can enter Caller IDs that will not be call forwarded.



Multi-Tenant Business Contact Center
Follow Me
Follow Me service rings destinations in a sequence set up by the user. If a call is not answered by 
the initial destination, the next destination in sequence will be dialed. For example, this allows you 
to set up your desk phone to ring first, for 10 seconds and if the call is not answered it will move 
forward and ring your cell phone for 10 seconds. In case you are unable to answer it, you can also 
set the call to return to your extensions voicemail, ensuring that you will receive the message from 
the caller once you are available.
Group Hunt
CSV upload allows you to easily create multiple entries for different IP PBX elements like Extensions 
and DIDs, or to quickly add or change prices for every destination in the service plan. 

Mobile Numbers
With Mobile Numbers, you can assign the Mobile Numbers you would like to receive calls from 
when you’re not in the office. If you enable the Mobile Numbers service and add a number to the 
mobile numbers list it will be displayed in Communicator as one of the destinations you can be 
reached on.
Speakerphone Page
Speakerphone Page allows you to broadcast a voice message to multiple extensions at the same 
time through the desk phone intercom. You can either create a list of specific Extensions you would 
like to page or you can add ALL extensions to avoid typing in all extensions numbers on the system/
tenant. In addition to this, IP PBX allows directed paging, in case you would like to broadcast the 
message to a specific extension only, and even directed two-way paging where a user is able to 
broadcast the message and listen to the response from other parties.
Speakerphone Paging Groups
Paging Groups feature works similar to standard paging, except this feature allows you to organize 
extensions to multiple paging groups and assign a unique number to each of them. As this feature is 
used with access code *600, the paging group number is entered after the access code. For example, 
if we assign number 300 to paging group and add 4 extensions to it, once we dial *600300 we will 
be able to broadcast the message over an intercom to all the extensions added to paging group 300. 
In Enhanced Services we are only able to allow or disallow whether extension will be able to use this 
service, while paging groups are created at Home -> Extensions -> Paging groups.
Directory / BLF List
The directory is used to enter a list of extensions you would like to have as contacts. When used 
with the Busy Line Field enabled phone, you can select some of those extensions to be monitored 
through the BLF buttons on your phone.



Multi-Tenant Business Contact Center
Speed Dial
Speed Dial service allows you to assign shortcode (up to 3-digits) to numbers you frequently dial so 
you don’t have to type the full number every time. To use Speed Dial you must dial ‘130 in front of 
your assigned shortcode (for example, *130 13).
Instant Recording
Instant Recording service allows you to start a call recording at any point of the call. To start recording 
the call, the user simply has to dial *159 access code.

Remote Access
Remote Access enables users to dial into the system from a remote location and authenticate to 
their personal extensions so they can make calls as if they were using their office phone.

Delete Recordings
Delete Recordings will give permission to the end user to delete recorded calls from their personal 
CDR list that they can reach by logging into their Online Self Care portal. Recordings will be deleted 
from the system, not just from users OSC CDR list. Although users can only delete a recording from 
the calls they made, you should be careful to which users this permission is assigned to.
Listen to Recordings
This service allows a user to listen to recorded calls by downloading them from the Online Self Care 
portal or by dialing access code *170 on their phone and then pressing numbers 1-9 for the last 9 
recordings, 1 being the newest.
Call Monitoring
This service monitors active calls in real time, allowing you to choose between three different 
monitoring options, listening, whispering and barging. The listening option allows you to listen to the 
calls, whispering allows you to listen to the conversation and talk only to the monitored extension 
and barging allows you to listen and talk to both parties on the call. All three options (Dynamic 
mode) allows you to dynamically choose what mode of monitoring you want to use during the call.
Phone Callback
Phone callback allows you to set up one or more Caller IDs that will be matched once a call gets 
to your IP PBX. Once the caller ID is matched, the call is dropped and the user will receive the call 
from IP PBX. Once the call is answered, the user is able to dial any destination as if they were using 
an office phone.



Multi-Tenant Business Call Center
“Confirm Calls” Disabled for Local Destinations
If enabled this will force the confirmation of the calls for local destinations. The option is available 
on “Group Hunt” and “Follow Me” Enhanced services. (external numbers still have to be confirmed).

Wake-Up Calls
A user can now call an access code *611 and use an IVR to set up a wake up call. They can also set  
up wake up calls for other extensions by calling *612. An admin must grant them this privilage by 
enabling the enhanced service for them.
BLF Cleanup
BLF buttons that are not set by autoprovisioning will be cleared if a checkbox has been selected.  

Supported phones: 

•	 Cisco SPA and the newest Cisco models
•	 Fanvil phones
•	 Gigaset Maxwell series
•	 Grandstream GXP series
•	 Grandstream GRP series
•	 Htek UC9xx series
•	 Obihai phones
•	 Vtech phones
•	 Yealink phones
•	 Snom phones
•	 Sangoma phones
•	 Polycom phones



CUSTOM EXTENSIONS
Multi-Tenant Business Contact Center

Custom Routing via Dial Plan
For advanced users IP PBX allows custom modifications directly from the dialplan configuration file, 
allowing you to customize routing beyond settings available in IP PBX GUI.

HOT DESKING
Hot Desking is a feature that allows employees to work at any available desk in an office and still be able to have their own extension. If the phone is set up 
to be used with hot desking, any user can log in to their own extension by entering the extension number and PIN. Only specific Polycom and Yealink devices 
are supported for hot desking.

Multi-Tenant Business Contact Center
Polycom
Hot desking support for Polycom devices - All Polycom devices
Yealink
Hot desking support for Yealink devices - All Yealink devices except T18
Cisco
Hot desking support for Cisco devices - 8865, 8851, 8841, 7821, 6851, 525G2, 509G and 508G
HTek
Hot desking support for HTek devices - All HTek UC9XX devices
Grandstream
Hot desking support for GXP1625, GXP1628, GXP1630, GXP1782, GXP2170 and GRP series 
phones
Gigaset
Hot desking support for Gigaset Maxwell Basic, 2, 3, and 4.
Emergency Caller ID Field
The emergency Caller ID field is attached to the Hotdesking entry, so when a phone logs in from 
a remote location, the Emergency Caller ID field under Enhanced Services will be replaced by the 
Hotdesking one.



Log out without PIN
To log out from a Hot Desking device, a user will need to dial *555 while logged in and this will log 
them out immediately. Minor database editing is required for this feature to be enabled.
HotDesking page - ‘Logout’ device button
Introduced a new optional button for each device on the HotDesking page to log out the device 
from the GUI. The button will only be visible if the device is currently logged in.
MAC address is in use
HotDesking warning shown when an existing MAC address is in use

RING GROUPS
Ring Groups are used to group a number of UADs/Phones into one network destination. Each Ring Group is assigned a network number which, once dialed, 
rings all extensions assigned to the group according to the ring strategy. 

Multi-Tenant Business Contact Center
Ring Strategy: All
Ring strategy All will ring all available extensions at the same time.
Ring Strategy: Round
Round ring strategy will ring each available extension in a specific order.
Ring Strategy: Round Memory
Round Memory ring strategy will ring each available extension in a specific order but it will begin 
with the extension that was last to ring on the previous call.
Ring Strategy: Least Recent
Least Recent ring strategy will ring the extension with the least answered calls.
Ringtone Customisation
IP PBX allows you to set up your ring group so phones use a different ringing sound if calls are 
coming from ring group.
Caller ID Customisation
Allows you to append the preferred string to the incoming caller ID number in order to distinguish 
the calls that are coming from the ring group or from other extensions.



Multi-Tenant Business Contact Center
Custom Greeting
Custom greeting can be played to callers once their call enters the ring group.
Exit Digit
Exit digit can be set to transfer the ring group call to the destination assigned as “Exit Destination”, 
usually an operator extension.
Incoming Call Confirmation
Enable Confirm Calls option to allow ring group members to be asked whether they would like to 
accept or reject the call coming from the ring group.
Paging Groups
Paging Groups feature works similar to standard paging, except this feature, allows you to organize 
extensions to multiple paging groups and assign a unique number to each of them. As this feature 
is used with access code *600, the paging group number is entered after the access code. For 
example, if we assign number 300 to paging group and add 4 extensions to it, once we dial *600300 
we will be able to broadcast the message over the intercom to all the extensions added to paging 
group 300.
Store Unanswered CDRs
Exclude unanswered CDR records from the report. 
If the option is set to ‘yes’ or ‘not set’ ring groups will behave the same as before. 
If the option is set to ‘no’ the following will change:
•	 The call was not answered/canceled: Instead of 2 generated CDRs per extension in the ring 

group, only a single CDR will be stored.
•	 The call was answered: Instead of 2 generated CDRs per extension in ring group a total of 

2 CDRs will be generated (one for the call to the ring group and one for the extension that 
answered)

Operation Times for “Ring Groups”
Set the “Ring group” open/closed times. Depending on the time when the call is received, the call 
can be redirected to different IP PBX destinations.
Limited Maximum Number of Extension that may be dialed when Ring Strategy is “All”
When strategy is “All” the default number of Extensions that may be dialed in a single Ring Group 
is set to 9. The limitation number for Ring Groups can be changed if additional configuration is set 
differently



TRUNKS/GATEWAYS
Multi-Tenant Business Contact Center

Protocols: SIP, IAX2, DAHDI
IP PBX Trunks/Gateways supports SIP and IAX2 protocols as well as DAHDI interface technology
DAHDI Signaling: PRI, & Analog
DAHDI signaling support PRI, and Analog PCI cards
Codec Selection
Every trunk on IP PBX can have a separate codec selection so you can make sure only the allowed 
codecs are in use when a call is passing through that trunk. Supported codecs: G.711 ulaw, G.711 
alaw, G.722, G.723.1, G.726, G.726 AAL2, G.729, GSM, iLBC, Speex, LPC10, H.261 Video, H.263 
Video, H.263+ Video, H.264 Video.
SIP and IAX2 Outbound Registrations
Trunks on IP PBX support SIP and IAX2 outbound registration.
DAHDI Hardware Supported: Digium Analog and Digital Cards
IP PBX supports Digium Analog and Digital PCI cards:TDM10B, TDM11B, TDM12B, TDM13B, 
TDM20B, TDM21B, TDM22B, TDM23B, TDM2400P, TDM30B, TDM40B, TDM410P, TDM800P
DAHDI Hardware Supported: Sangoma Analog and Digital Cards
IP PBX supports Sangoma Analog and Digital PCI cards, A500, B700, A200, A400, A601, A700, 
AFT-B600.
DAHDI Hardware Supported: OpenVox Analog and Digital Cards
IP PBX supports OpenVox Analog and Digital PCI cards: A400P/E, A400M, A810P/E, A800P/E, 
A1200P/E, A1610P/E, A2400P/E, D830P/E, D430P/E, D230P/E, D130P/E, D410P/E, D210P/E, 
D110P/E.
DAHDI Hardware Supported: Xorcom Astribank
Support for Xorcom Astribank VoIP gateway.
Check for Additional Headers
This field should have a comma separated list of Headers to look out for. If a call comes to a trunk 
and has a header set that is in this list then that header will be preserved for when call leaves the 
system.



SIP TRANSPORTS SUPPORTED
Multi-Tenant Business Contact Center

UDP
IP PBX supports UDP transport. With UDP, computer applications can send messages, in this case, 
referred to as datagrams, to other hosts on an Internet Protocol (IP) network without having prior 
communications to set up special transmission channels or data paths.
TCP
IP PBX supports TCP transport. TCP provides reliable, ordered, error-checked delivery of a stream of 
octets between programs running on computers connected to local networks or the public Internet.
TLS
IP PBX supports SIP/TLS transport but it is important that clients also support TLS and that they are 
set up accordingly. TLS is a cryptographic protocol and it provides encrypted communication over 
the Internet improving security.
Customizing TLS Bind Port
This port overrides any TCP/UDP settings in the SIP protocol settings and applies for all users 
(external/internal).

SIP GENERAL SETTINGS
Multi-Tenant Business Contact Center

NAT Settings
IP PBX NAT settings allow you to configure settings according to network configuration on location 
from which devices are registering to IP PBX.
Registrations
An administrator can customize SIP registration settings to preferred values. It is possible to change 
settings for the length of incoming and outgoing registrations, Registration context, Registration 
timeout etc.



Multi-Tenant Business Contact Center
Codecs
IP PBX supports a number of different codecs: G.711 ulaw, G.711 alaw, G.722, G.723.1, G.726, 
G.726 AAL2, OPUS, G.729, GSM, iLBC, Speex, LPC10, H.261 Video, H.263 Video, H.263+ Video, 
H.264 Video.
RTP Timers
RTP timers define a time period after which calls will be terminated if there is no RTP activity.
SIP Timers
IP PBX has 3 parameters for SIP timer:
1.	 Minimum round trip time for a monitored host that defines minimum round trip time for messages 

to be monitored (default 100 ms).
2.	 Default T1 timer is the estimated round trip time of an IP packet.  By default, T1 is set to 500 

milliseconds
3.	 Call Setup Timer - this timer defines the period after which a call will auto congest if a response 

was not received. Default value is 64 * [T1 timer]”
MWI
Message Waiting Indicator (MWI) is a feature that informs users that they have a new voicemail 
message(s) waiting in their mailbox. In its most common form, this feature lights a lamp on a phone 
to indicate the presence of a voice message. 
Subscriptions
SIP protocol includes a standardized mechanism to allow any SIP client, for example, your desk 
phone, to monitor the state of another device. So for example, if you would like to monitor 
whether your coworker is on the phone or not, your phone must send the SUBSCRIBE 
request, either directly to your coworkers desk phone or to a server that is aware of the 
state of the device. If the SUBSCRIBE request is successful, then every time that device 
changes state, your desk phone will receive a SIP NOTIFY message telling it about the 
event or change of status. This is the mechanism that IP phones use to control BLF lamps. 
 
IP PBX enables you to make changes to subscription settings. You can use Allow Subscription setting 
to disable/enable subscription support, you can set a specific context for SUBSCRIBE requests with 
Subscribe Context. enable disable Notify on RINGING or Notify on HOLD.
Video Support
IP PBX natively supports SIP video but in order to use it, some settings will need to be enabled on 
the extension settings page as well as on the device itself.
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Remote-Party-ID
IP PBX supports SIP Remote-Party-ID (RPID) and allows you to use services like Caller ID and Caller 
ID blocking. Not setting the RPID on your server in some situations can cause the preferred Caller 
ID not to be delivered to the called party (in which case the default Caller ID assigned by your 
provider might be used instead) and it can also prevent you from hiding your Caller ID if necessary. 
This, however, will mostly depend on your provider’s requirements.
SIP Debugging
SIP debugging features available in shell and Asterisk CLI are adding an additional layer of information 
necessary for troubleshooting when the data available in CLIRs is simply not containing all the 
necessary information. To fully utilize these features the user will require advanced experience with 
IP PBX and Asterisk.
QoS
QoS settings on IP PBX allow administrators to prioritize traffic in their local network, improving call 
quality in busy and networks with low Internet bandwidth. In order for this to work, QoS rules must 
be set on IP PBX and on the networking devices (routers/modems).

CODECS
Codecs are used to convert an analog voice signal to a digitally encoded version. Codecs vary in the sound quality, the bandwidth required, computational 
requirements, etc.
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G.711 uLAW
Support for G.711 uLAW codec.
G.711 aLAW
Support for G.711 aLAW codec.
G.729 - Royalty free
Support for G.729 - Royalty free (License included with IP PBX 5.0).
G.722
Support for G.722 codec.
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G.723.1
Support for G.723.1 codec.
G.726
Support for G.726 codec.
GSM
Support for GSM codec.
iLBC
Support for iLBC codec.
Speex
Support for Speex codec.
LPC10
Support for LPC10 codec.
H.261 Video
Support for G.722 codec.
H.263 Video
Support for H.263 Video codec.
H.263+ Video
Support for H.263+ Video codec.
H.264 Video
Support for H.264 Video codec.
Opus
Support for Opus codec.
Default Codecs for Newly Created Tenants
When creating a new tenant the Codecs set will be inherited from Master Tenant instead of being 
hardcoded.



ONLINE SELF CARE
Online Self Care portal allows the end user to modify their extensions settings according to assigned permissions. Users can edit Enhanced Services settings, set 
up voicemail behavior, check CDRs, download call recordings etc.
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Dashboard
IP PBX, the new OSC portal also has a Dashboard that displays all the relevant information about 
users calls for that day. On the dashboard, users can see their voicemail status, the total number 
of calls, the number of answered calls, talk time, and funds spent. In addition, the status for Call 
Forwarding and Do Not Disturb services is displayed, to help prevent scenarios in which users 
forget to disable these services, causing their calls to be forwarded or rejected.
Account Details Changes
Online Self Care portal allows the end user to modify extensions, email address, password and PIN.
Voicemail
End users can download and listen to received voicemail messages and modify their voicemail 
settings for their extension from the Online Self Care portal.
Voicemail Speech to Text
This feature will allow customers to attach the transcript of voicemails when sending out emails to 
users as well as being able to access the transcripts inside OSC. Two transcription services will be 
supported in this version, Google Speech and IBM Watson.
Speech to Text Additional Languages
Speech-to-text now supports Spanish and French language.
Reports
Online Self Care portal allows end users to see their call records, filter them by date, time and caller 
ID, print or email CDR search results.
Call Recordings
In addition to checking their CDR records, end users are also able to listen and download their Call 
Recordings from the CDR page in the Online Self Care portal.
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Enhanced Services
If permitted by the IP PBX administrator, users can edit the Enhanced Services settings from their 
Online Self Care portal.
Enhanced Services Status
Status for the Call Forwarding and Do Not Disturb services is displayed, to help prevent scenarios 
in which users forget to disable these services.
Destinations Permissions
If permitted by the assigned Service Plan, users can edit their Destinations Permissions from the 
Online Self Care portal.
Registered Devices
With multiple registrations available, users can also see what devices are registered to their 
extension and from which IP address. We combined geo IP lookup with this feature, so if the device 
is registering from a public IP address, a flag icon will appear next to the registered device name, 
representing the country in which that particular IP is located. This should help users to notice and 
report any unusual registrations to their extensions.
Today’s Calls
The total number of calls, the number of answered calls, talk time, and funds spent.
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CSV Upload
CSV upload in DIDs page allows you to create a large number of DIDs by simply uploading a .csv file 
with the DID numbers and preferred settings.
CSV Download
CSV Download, in the DIDs page, allows you to download the full .csv file with DID list and its 
defined settings.
DID Groups
To make DID management easier the Multi-Tenant DID section has a new feature for master 
administrator users. When the DID mode is set to “groups” (under the master tenant settings), the 
administrator can assign a range of DID numbers to a DID group which can later be assigned to a 
particular tenant. The tenant administrator can later distribute and set up DID numbers from this 
group however preferred (single DID or a range of numbers) without needing a IP PBX administrators 
assistance.
Available Numbers for a DID Group
The DID Mode needs to be set to Group. When adding/editing a DID the following things have 
been changed:
1.	 After you choose a group, the DID/Channel field will be changed to a drop-down, depending on 

some rules (written under)
2.	 The dropdown will be used as an autocomplete feature and will show available DIDs from the 

chosen group
3.	 A maximum of 10 DID numbers are shown at a time so to narrow your choice you need to type 

in more characters 
4.	 The drop-down will show only available DIDs, meaning that those already reserved/created will 

not be shown
Enable / Disable Local DID Matching
Forces the call to leave the system without trying to match a dialed number with a local DID. Option 
available only on master tenant/server.
Destinations: Extension
Assigning Extension as a destination for DID will allow an administrator to forward calls directly to 
specific extensions.



Multi-Tenant Business Contact Center
Destinations: Ring Group
Assigning Ring Group as a destination for DID will allow administrator to forward calls directly to 
specific Ring Group.
Destinations: Multi-User Extension (DID Forwarding)
Multi-User Extension is used for DID forwarding, in cases where remote system trunk is registering 
to IP PBX extension, which allows IP PBX to pass inbound calls to the remote PBX system.
Destinations: Multi User DID Controlled by License.
Setting IVR (Interactive Voice Response) as a DID destination will enable callers to choose one of 
the multiple available selections by entering the assigned number on their phone keypad. 
Destinations: IVR
Setting IVR (Interactive Voice Response) as a DID destination will enable callers to choose one of 
the multiple available selections by entering the assigned number on their phone keypad. 
Destinations: Queue
When set as a IP PBX destination, calls will be forwarded to the Queue where they will wait, listening 
to Music on Hold and/or pre-recorded announcements, until they are served by an available Agent.
Destinations: Voicemail
If preferred DID calls can be forwarded to extensions voicemail directly, even if user is available.
Destinations: Conference
Setting Conference room number as a DID destination will allow callers outside the company to join 
conference calls by dialing the DID number.
Destinations: Remote Access
Remote Access can be set as a DID destination to allow users to make calls from their extension 
even when they are not in the office. When a user dials the DID number to set to use Remote 
Access they will be asked to enter their extension number and PIN. Once the user is authenticated 
they can make calls to allowed destinations, check voicemail or even log in as a queue agent.
Destinations: Use PBD Pin as DID Remote Access Authentication
Users can chose PBD authentications for DID remote access.
Destinations: Trunk
When a trunk is set as a DID destination IP PBX will act as a gateway and it will simply pass the calls 
to a remote system through a specified trunk, where it will be routed accordingly.
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Destinations: Fax to E-mail
Set Fax to E-mail as a DID destination if you would like to receive faxes on IP PBX. A Fax will be sent 
to an e-mail address (if the SMTP server is configured on IP PBX) and saved on IP PBX where it can 
be downloaded from the FAX section.
Destinations: External Number
You can set an External Number as a destination to forward the calls to numbers that are not 
terminating on IP PBX, for example, a user’s cell phone number.
Destinations: Phone Callback
Status for Call Forwarding and Do Not Disturb services is displayed, to help prevent scenarios in 
which users forget to disable these services.
Destinations: Deny Access
When used, the Deny Access destination plays a busy sound to all the callers that dial that DID 
number.
Operation Times
Operation times is a feature that enables you to forward DID calls to a destination different from 
the one that is set in DID, based on date, day and time.
Caller ID Validation & Routing
This option is used to fine-tune functionality of the DID by adding rules according to which calls will 
be routed to the preferred destinations based on the rule associated with specific Caller ID.
Custom Ringtones
The custom ringtones feature allows you to set up your DID so your phone uses a different ringing 
sound when calls are routed to your phone from a specific DID.
Caller ID Replacement
Allows you to append the preferred string to the incoming caller ID number in order to distinguish 
calls coming from the specific DID versus every other call.
Call Recording
Call recording can be enabled on the DID as well as on several other places on IP PBX, however, if 
enabled on DID, call recording will have the entire length of the call in a single sound file, even if the 
call was transferred more than once.
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Queue Priority
Queue priority option allows you to assign certain levels of priority for calls that are being forwarded 
to the Queue. You can set up a queue priority level to give calls higher or lower priority compared 
to calls entering the queue from other destinations.
Billing: Specific Service Plan
Creating multiple service plans enables you to easily assign or change call prices which will be used 
by all extensions that are set to specific service plans. Creating multiple Service Plans allow you 
to set up extension pricing based on the package you are selling to that particular user or group 
of users. In addition to this, Service Plan allows you to create a template with a specific set of 
Enhanced Services and/or Destinations permissions which will be enabled for extensions that are 
assigned with particular service plans, preventing manual labor which would be needed if every 
extension was to be set manually.
Billing: Use Billing Extension for Billing
You can easily manage inbound calls billing on DIDs by assigning the Billing Extension number and 
automatically deduct the funds from extensions account balance for every inbound call made.  
Billing: Force Codec
Enables you to force a specific codec to be used for all calls that come to the DID when this feature 
is enabled on.
Billing: Strip Digits
If your calls are being directed to a trunk, it is possible to define the number of digits which will be 
stripped from the beginning of the incoming call number in order to meet the dialing rules specific 
to that trunk provider.



CALLER ID VALIDATION & ROUTING

This option is used to fine-tune functionality of the DID by adding rules which route the calls to different destinations based on incoming Caller ID.
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Match Explicitly
Match Explicitly will inform the system to explicitly match the numbers with identical Caller ID as 
stated. For example, if you would like to block a particular number you would enter that number, 
select block and set Match Explicitly to yes. This will ensure only the entered number is blocked 
once it reaches the DID.
Match Partially
This option will inform the system to match all the Caller IDs that start with a specific number. For 
example, if you are receiving calls from a range of numbers originating from a foreign country you 
would like to block, you could enter the starting digits that are in common for all the Caller IDs 
you were receiving nuisance calls from. This will prevent all the calls from that particular range to 
be blocked or forwarded, depending on your preference. NOTE: Unless you would like to block all 
the inbound calls originating from a specific country, try to extend the range of numbers to at least 
cover the area code alongside the country code to minimize the range you are trying to block.
Custom Destinations Identical to DID Destinations
Destinations used for Caller ID Validation and Routing can be set to the same values available on 
DIDs.
CLI Validation & Routing per Tenant
CLI Routing and validation per tenant (the tenant administrator can manage the validation and 
routing per tenant). This option is used to fine-tune the functionality by adding rules which send the 
calls to different destinations based on Caller IDs. 
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Limit Maximum Number of Participants
Allows you to define the maximum number of users that can join the conference.
Instant Conferences via Desktop App
Integration with Communicator allows you to create dynamic conferences by dragging users into 
an active call.
Conference PIN
Enables you to define Conference PIN all users must enter in order to join the conference.
Conference Admin PIN
Enables you to define Conference Admin PIN to authenticate user as a Conference Admin in order 
to assigns administrative privileges.
Conference Marked User PIN
Enables you to define Conference Marked User PIN to authenticate user as a Marked user in order 
to assign set of privileges.
Dynamic PIN Prompt
Enables you to define Conference PIN all users must enter in order to join conference.
Announce User Join/Leave
When joining a new conference, members will be asked to say their name and press the ‘#’ key 
before they enter the conference. Their name will be recorded and played to other conference 
members when a caller joins/leaves the conference.
Announce Number of Participants
Turning on this option will announce the number of conference participants to a new conference 
member. e.g “There is currently one other participant in the conference.”
Email Conference Recording
At the end of a conference call (static not dynamic) if the email is in there as an option the sound 
file of the conference would be emailed to a pre-specified email once everyone has exited the room.
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DTMF Menu for Participants
When marked as a conference admin users are able to perform several actions:
1.	 Mute Control: Conference Admins are able to mute a specific user.
2.	 Volume Control: Conference Admins are able to adjust the speaking volume for an entire 

conference room.
3.	 Kick Users: Conference Admins are able to kick specific user(s) from a conference room.
4.	 Eject Users: Conference Admins are able to use the eject command to kick out the last user that 

joined the conference room.
5.	 Lock Conference: Conference Admins are able to lock the conference room, preventing new 

callers from joining in.
6.	 Record conferences: Enables recording of the conference room calls.
7.	 Music on Hold: This option will play Music on Hold to the first user that joins the conference. As 

soon as the second user enters the conference room Music on Hold will stop playing and users 
are able to talk to each other.

8.	 Wait for Marked User to Start Conference: Enabling this option will prevent users to talk to 
each other until the marked user joins the conference, this is useful when you are arranging a 
conference call between multiple parties that are unfamiliar with each other.

9.	 Close the Conference when Marked User Leaves: Closes the conference when last marked 
user exits, regardless of the number of active participants in the conference room, their calls will 
be immediately dropped at that moment.

10.	Control Members of Conference: Conference admin is able to mute, add or remove conference 
participants.

Control Options for Each Member:
It is possible to assign conference privileges on per extension basis. Available control options for 
each member are:
1.	 Admin: If this option is enabled, conference calls coming from the extension will be treated with 

admin privileges.
2.	 Marked: If this option is enabled, conference calls coming from the extension will be given fewer 

privileges than the admin, but more than regular conference participants.
3.	 Talk-Only: If this option is enabled, conference calls coming from this extension will be allowed 

to talk only and no sound from the conference will be heard on that phone.
4.	 Listen-Only: If this option is enabled, conference calls coming from this extension will be allowed 

to listen only and no sound from the extension will be heard in the conference.
5.	 Exit Digit: If this option is enabled, users will be allowed to exit the conference by dialing any 

digit on their phone.
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Standard IVR
IVR (Interactive Voice Response) is an automated answering machine which will guide callers to their 
destination by providing a number of choices and waiting for the caller to make a selection through 
DTMF tones via a device keypad.
Pin-Based IVR
PIN-Based IVR allows dialing to local/remote destinations by providing a pre-set IVR PIN number. 
Multi-Digit IVR
Unlike regular IVR, Multi-digit IVRs accepts two or more digits as a response from the caller, therefore 
providing a wider range of options compared to Standard IVR.
Meeting IVR
Meeting IVR is selected when a user wants to join the Conference only via audio. A user needs to 
call a DID that is connected to a Meeting IVR and follow the instructions in order to join a Meeting. 
The necessary information (Meeting Number and Participant ID) is provided in an e-mail when the 
Meeting is being created.
IVR Tree Builder
IVR Tree is a special form of IVR where creation of a particular IVR is more graphically oriented than 
it is with regular IVRs. This allows better overview when creating more complex IVR system in which 
callers have to navigate through multiple IVRs in order to reach preferred destination.
IVR Destinations: Extension
Setting up an extension as a destination in IVR will forward the call to a specified extension number 
once the assigned digit is pressed.
IVR Destinations: IVR
Setting up IVR as a destination in IVR will forward the call to a specified IVR number once the 
assigned digit is pressed.
IVR Destinations: Queue
Setting up Queue as a destination in IVR will forward the call to a specified Queue number once 
the assigned digit is pressed.
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IVR Destinations: Conference
Setting up Conference as a destination in IVR will forward the call to a specified Conference number 
once the assigned digit is pressed.
IVR Destinations: Voicemail
Setting up a Voicemail as a destination in IVR will forward the call to a specified extension number’s 
voicemail directly, without dialing the extension, once the assigned digit is pressed.
IVR Destinations: Remote Access
Set Remote Access as an IVR destination to enable users to dial into the system from a remote 
location and authenticate to their personal extensions and make calls as if they picked up their office 
phone.
IVR Destinations: Directory
With this option selected, you will have the ability to dial an extension by entering the first three 
letters of the extension’s last or first name.
IVR Destinations: Fax to E-mail
Set Fax to E-mail as an IVR destination if you would like to receive faxes on IP PBX. Fax will be sent 
to an e-mail address (if the SMTP server is configured on IP PBX) and saved on IP PBX where it can 
be downloaded from the FAX section. 
IVR Destinations: Call External Number
In order to dial a specific number as an IVR selection, you must select Call External Number as a 
destination in IVR and enter the number which will be dialed once the selection is made.
IVR Destinations: Ring Group
Setting up Ring Group as a destination in IVR will forward the call to specified Ring Group number 
once assigned digit is pressed.
IVR Destinations: Remote Access
Setting up Remote access as a destination in IVR will allow the caller to use Remote Access 
functionality.
IVR Destinations: CRM Routing 
Setting up CRM Routing as a destination in IVR will allow the caller to use CRM Routing, which 
allows routing to a specific Queue or IVR or playing sound files based on information fetched from 
CRM
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IVR Destinations Options: Default Caller ID
You can append the preferred string to incoming Caller ID (for example IVR 1) to differentiate 
between multiple destinations that calls can come from.
IVR Destinations Options: Change Language
If sound files in languages other than English are uploaded to IP PBX, alongside the defaulted 
English language prompts, you can set voice prompts to be played in the preferred language once a 
call is routed to its destination.
Operator Extension
Operator extension option allows you to assign the number of extension to which calls will be 
redirected to if ‘IVR Status’ is set to ‘Off’.
Custom Timeouts
Allows administrators to set preferred time values for Response Timeout, Digit Timeout, Selection 
Timeout etc. In case any of these timeouts are exceeded a voice prompt will be played back to the 
user several times, after which, the call will be dropped.
Custom Greeting
Custom greeting enables administrators to play a greeting with IVR instructions once the caller gets 
to the IVR.
Change Greeting Access Code for a Specific Destination Type
Users are able to change a greeting themselves without the admin making any changes to the file 
name and assign it to an IVR greeting. Two new access codes have been added:

1.	 Change Greeting: defaults to *303 and takes a queue/IVR or ring group as the destination. 
When dialed the user is prompted to record a new greeting. Once accepted the greeting is set 
as the destination’s new greeting. 

2.	 Change Greeting: defaults to *304 and takes a queue/IVR or ring group as the destination. 
When dialed the user is prompted to record a new greeting. Once accepted the greeting is set 
as the destination’s new greeting, and the old greeting, if it existed, will be deleted.

IVR Extension Exclusion
A new field under “IVR > Local Dialing” called “Exclude list” has been added. Any extension added in 
field cannot be called form that IVR even if it is within the set range.
IVR Extension Range
When enabling local dialing on IVR, it is possible to exclude 1 or 2 extensions from this.
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IVR: Add # Option
Allow # to be used as an IVR option.
Ringing Type
This option allows you to set whether you would like to play Music on Hold or a ringing sound to 
callers once their call reaches the IVR.
Dial Local Extensions Directly
This feature allows callers to dial an extension number directly, once their call enters the IVR. If this 
feature is enabled anybody that enters the IVR will be able to dial extensions on the system/tenant 
directly if they know the number that would like to dial. This option can be used alongside standard 
IVR selections.
Dial Local Extensions Limits
Administrators are able to restrict extension dialing from IVR by defining a range of extensions that 
are allowed to be called directly. 
Dial Permissions
Permissions are used to allow an organization to restrict who is able to enter an IVR. In particular, 
there are organizations where access to the IVR is only allowed to callers with a valid account 
number, but it can be used for other similar purposes.
Operation Times
Operation times enables the administrator to forward calls that are supposed to enter IVR to a 
different location depending on the date, day and time.
FAX Detection
When FAX recognition is enabled on your IP PBX system, you can turn on FAX detection on your 
IVR by entering an e-mail address in the FAX Email field. This will automatically accept all FAX calls 
and send received FAXes to that e-mail address without any additional actions from the sender.
Disable CallerID (PIN-based IVR only)
This option disables CallerID but only for PIN-based IVRs.
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With this option selected, you will have the ability to dial an extension by entering the first three letters of the extension’s last or first name.
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Search by First Name
With this option selected callers will have to enter the starting letters of a users first name in order 
to dial their extension. This is done by entering numbers that correspond with letters on the keypad 
on the phone/softphone the caller is using.
Directory DTMF Timeout
After entering directory from IVR for example, from that moment you only have 3 seconds to start 
typing in the first 3 letters of a last name if you do not do that call gets disconnected.
Directory DTMF exit key can be customized
The user can exit the Directory app at any moment by pressing the ‘#’ or ‘0’ key.
Search by Last Name
With this option selected callers will have to enter the starting letters of a users last name in order 
to dial their extension. This is done by entering numbers that correspond with letters on the keypad 
on the phone/softphone the caller is using.
Search by First and Last Name
With this option selected callers will have to enter the starting letters of a users First or Last name 
in order to dial their extension. This is done by entering numbers that correspond with letters on the 
keypad on the phone/softphone the caller is using.
Play Voicemail Greeting for Name
If a name is recorded in the voicemail box by a user, the message will be played in the IVR directory 
instead of automated spelling.
IVR Directory Filter per Department
This feature simplifies the search inside the IVR Directory by limiting searches to a group of extensions 
(departments) instead of the entire directory. This feature will assist when searching through the IVR 
if there are duplicate names in a system.
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Same as regular IVR, IVR tree offer multiple available options for destination type.
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Dial Local Extension
Dial Local extension feature will allow you to assign a local extension as an IVR Tree destination.
Dial Remote Extension
This feature allows you to assign an external number as an IVR Tree destination.
Dial Voicemail
This feature allows you to assign an extension voicemail as an IVR Tree destination.
Check Voicemail
Set up Check Voicemail on IVR Tree to allow users to log in to their extensions voicemail and check 
messages without using their extension.
Go to Context
Setting Go to Context on IVR Tree will forward calls to given context and extension.
Start Recording
Call recording will be enabled from point in which call gets to branch of IVR tree with Start recording 
enabled.
Set Queue Priority
Queue priority option allows you to assign certain level of priority for calls that are being forwarded 
to Queue. Set up a queue priority level to give calls higher or lower priority compared to calls 
entering the queue from other destinations.
Set Language
If sound files in language other than english are uploaded to IP PBX alongside default English 
language prompts, it is possible to set voice prompts to be played in preferred language. 
Play Sound
This selection will play selected sound file in multiple languages (if available). In addition, it is possible 
to allow DTMF entries, enabling callers to dial local destinations.
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Change Caller ID
You can append preferred string to incoming Caller ID (for example IVR Tree 1) to diferentiate 
between multiple destination calls can come from.
Wait
This option allows you to set pause time in seconds after which IVR will continue executing assigned 
actions actions.
Busy Signal
When selected, this option will play Busy signal to callers.
Hangup
This action will hang up incoming calls upon execution.
Go to IVR Tree
This option will forward calls to other IVR Tree destinations.
Local/Remote Destinations
IVR Tree supports forwarding calls to both Local and Remote destinations.
Voicemail
IVR Tree supports Voicemail as an IVR destination.
RIng group
IVR Tree supports Ring Group as an IVR destination. 
Queue
IVR Tree supports Queue as an IVR destination.



PIN BASED IVR

PIN-based IVR allows dialing local/remote destinations by providing a pre-set IVR PIN number
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CSV Upload
PIN-based IVR allows you to create a large number of PIN numbers and matching destinations by 
uploading a CSV file.
Expiry Date per PIN
PIN Expiry date allows the IP PBX administrator to define the PIN expiry date, rendering it unusable 
after a specified date.
Destination per PIN
Every created PIN is assigned to a specific destination, once the pin is entered in PIN based IVR, the 
matching destination will be dialed.

IVR STATISTICS
We have added a new feature called IVR statistics, this feature is similar to Queue or Agent statistics for Call Center systems.
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IVR Calls
IVR call statistics report will show: Callid, Date time, Called Number, Callerid, IVR name, IVR number, 
Option, Destination, Dest. Type, Ended
IVR Calls per Called Number
IVR calls per called number report will show: Called Number, Date Time, Callerid, Callid, IVR name, 
IVR number, Option, Destination, Dest. Type, Ended
IVR Calls per Option
IVR calls per option: Callid, Date time, Called Number, Callerid, IVR name, IVR number, Option 
Destination, Dest. Type, Ended
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IVR Calls per DID in IVR Statistics
IVR statistics page has been enriched with a new report page called “IVR calls per DID”.

REMOTE ACCESS
In most cases, Remote Access is set as a DID destination (although it can be set as an IVR destination as well) in order to allow users to make calls from 
their extension even when they are not in the office. When a user dials the DID, the number is set to use Remote Access. They will then be asked to enter the 
extension number and PIN. Once a user is authenticated they can make calls to allowed destinations, check voicemails or even log in as queue agent. 

Multi-Tenant Business Contact Center
Destinations
Set destination to Remote Access in order to allow users to log in to their extension and make calls 
from it as if they were using their desk phone.
Voicemail
Voicemail can be assigned as a Remote Access destination in order to allow users to check their 
voicemail when not in the office.
Agent Login
Voicemail can be assigned as a Remote Access destination in order to allow users to log in as agents 
even if they are not using a IP PBX extension.

OPERATION TIMES

Operation times is a feature that enables you to forward IVR calls to different locations depending on the date, day and time.
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Default Destination
Destination, different from the one set on IVR, where calls will be forwarded according to the 
Operation Times rules.
Custom Destinations for a Specific Day/Time Range
You are able to define a specific day/time range when calls will be forwarded to a custom destination.
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Control Open Days and Hours
You are able to define the day/time range after which calls will be forwarded after working hours.
Control Closed Dates and Hours
You are able to define a default destination where calls will be forwarded during closed dates.
Custom Greeting
Create a custom greeting and assign it to Operation Times to inform customers that their call will 
be forwarded to a different destination because your office is closed.
Midnight Reset for Operation Times
In Access Codes → Edit, the Operation Times group feature called “Midnight reset” is available. By 
default this option is set to “Yes”, meaning that the access codes will be reset in midnight. If set to 
“No”, the midnight reset will be skipped.
Import and export csv for operation times
Operation Times configuration can be exported into csv or imported from csv file.

QUEUES
Queue system allows you to receive more calls in your IP PBX than your staff members are able to answer at the same time.
NOTE: Queues in MT edition have fewer options available. For example, Agents are not available on MT and only static members (SIP extension) can be added 
to the queue members list.
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QUEUE RING STRATEGIES
Queue ring strategies allow you to distribute queue calls more efficiently and according to your 
specific needs. You can assign one of the available strategies to your queues in order to ring queue 
agents or static members randomly or in a specific order.
Queue Ring Strategies: Ring All
When the Ring All ringing strategy is selected, once a call enters the queue it will ring all available 
queue members at the same time.
Queue Ring Strategies: Linear
When the Linear ring strategy is selected, once a call enters the queue it will ring available queue 
members one by one in a specific order.
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Queue Ring Strategies: Least Recent
The Least Recent ring strategy will ring available agents with the least answered calls in order to 
distribute the calls evenly between all queue members.
Queue Ring Strategies: Fewest Calls
The Fewest Calls ring strategy will ring available agents with the fewest calls received in order to 
distribute the calls evenly between all queue members.
Queue Ring Strategies: Random
Random ring strategy will randomly ring any of the available queue members.
Queue Ring Strategies: Round-Robin with Memory
You are able to define the day/time range after which calls will be forwarded after working hours.
Queue Ring Strategies: Round-Robin Ordered
Same as Round-Robin with memory, except the queue member order from the config file is preserved 
so interfaces will ring in the order specified in the configuration file. If you use dynamic members, 
the members will be rung in the order in which they were added
Queue Ring Strategies: Random with Penalty
The Random with Penalty ring strategy will randomly ring available members of the lowest penalty 
level. In case all the members of that penalty are busy or not available, the call will move to members 
with a higher penalty level assigned.
Music on Hold
This option allows you to enable music on hold for callers that are waiting in the queue. 
Custom Ringtones
IP PBX allows you to set up your queues to send a matching string to the phone so it is informed to 
use a different ringtone when calls are coming from the queue set up with this option. In order to 
use this feature, alongside IP PBX, part changes must be made in the phone as well. For information 
on how to set up the phone please consult your device admin manual.
Caller ID Replacement
Caller ID Replacement allows you to append the preferred string to the incoming caller ID number 
in order to distinguish calls coming from the queue or from other calls to an extension, for example 
Queue 1.
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Custom Sounds
You can record your custom sound files like Greeting, Periodic Announce, Agent Announce, Callback 
announcements for Caller and Agent.
Ringing Timeouts
Ring timeouts allow you to define how long will call ring each queue member before it continue to 
the next available member.
Waiting Timeouts
Define the total time the call spent in the queue and what should happen with unanswered calls and 
where they should be routed after timeout is reached.
Announcements
Queue Announcements inform callers waiting in the queue what their current position is and for 
how long (approximately) they should wait before their call is answered.
Periodic Announcements
Periodic announcement option allows you to play a custom message to the callers waiting in the 
queue.
Call Recordings
In order to allow you to preserve important customer calls IP PBX queues also offer the option to 
record all queue calls.
Exit Digit
This option allows you to define Exit Digit which will be used to allow users to drop out of queue 
calls. Depending on the queue settings they can be forwarded to an operator extension, voicemail 
or to initiate queue callback.
Abandoned Calls E-mail Notification
When Abandoned Calls E-mail Notification is enabled, IP PBX will send reports, once per hour, with 
information on all abandoned queue calls and the reason why the calls were dropped.
Queue Callback
Depending on the queue settings, Queue Callback will initialize the call to numbers that dropped 
in the queue before they were served by Agents. Queue Callback has a number of options that will 
allow you to fine-tune it according to your personal preference.
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Queue Callback IVR
In addition to the default Queue Callback setting that uses Caller ID to initialize the call, Queue 
Callback IVR allows users to enter different caller ID number from the one they are using.
Static Member Login
Queues on IP PBX Business and Call Center edition offer options to allow static members (SIP 
extensions) to log in and log out of the queue in the same manner as Agents.
Prevention of Enhanced Services for Static Members
This option allows you to choose whether extensions in Enhanced Services should apply to queue 
static members. The option is called Disable Member Enhanced Services. When set to Yes, ES 
rules will not be applied when the Queue dials static members. 
NOTE: This only applies to Static Members with no login and Callback Agents or DynamicAgents that 
have ES disabled by default.
Queue Members Management
You can easily add and remove queue members from the queue members management panel. 
Queue Member Penalties
Assigning different penalty levels to queue members will help you achieve more precise call distribution 
in your queues. Members with a lower penaltiy number will receive calls until all members with that 
penalty are busy or unavailable, which will move the call to members with a higher penalty number.
Desktop App Integration
IP PBX Call Center integration with desktop clients Communicator Agent and Communicator 
Supervisor will allow you to improve your employee’s performance by speeding up their workflow.
Caller ID for Queue Callback
Caller ID for callback is a new queuing feature in our Call Center Edition. When a customer receives 
a call from the Queue Callback you can choose a Caller ID to display.
Caller Early Hangup
When a call comes into the system via DID and the call is hung up while the greeting is played, 
the call still passes to the Queue because of statistics. So, users are aware they have abandoned 
calls. This is a new option in the queue and can be disabled or enabled per the user’s preference. 
Basically, if the user wishes to pass abandoned calls to the queue, they can still have these calls in 
statistics. If calls are abandoned during the greeting and are detected and not routed, it will also 
show in the statistics.
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Disabled Queue Calling to Mobile Endpoints in IP PBX
Disabled queue calling to mobile endpoints in IP PBX.
Limited Number of Members to Ring for ringall Strategy
When strategy is “ringall”,  the default number of Queue Members and Agents that may be dialed 
in a single Queue is set to 9. The limitation number for a Queue can be changed per single Queue 
if additional configuration is set differently. 
Better control over announce
Position and Periodic announces are split into separate sections. Also, we added option to choose 
if one want to hear Hold-Time or Position announce or both. 

SKILL BASED ROUTING (SBR)
Different agents in queue can have different penalties. SBR allows one to create Sets of Rules to change the value of the Min Penalty and Max Penalty channel 
variables in mid-call. This means that it is possible to open a call to more members or potentially a different set of members. Agents with different penalties can 
answer a call in different period of time, depending on the Rule. On each queue one can choose which rule to use or no rule to use.
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Rule configuration
Using this one can controll when Rule’s configuration will be changed (Caller Hold Time) and which 
agents can answer the call (using Min and Max penalties).

QUEUE MONITORING
Queue monitor is useful tool that will display information on Agent status (Unavailable, Idle, On call), and some Basic queue information (Answered calls, 
Abandoned calls, current number of calls waiting in queue etc.), or one can select specific queue to show detailed information about it.
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Calls Waiting
Queue monitor Calls Waiting section displays total number of calls waiting in queue.
Average Calls Waiting
Queue monitor Average Calls waiting section displays average time calls were waiting in queue.
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Agents Logged
Queue monitor Agents Logged section displays information on number of logged in agents.
Agents on Call
Queue monitor Agents on Call section displays information on agents on call.
Agents Idle
Queue monitor Agents Idle section displays information on number of idle agents.
Agents Not Logged
Queue monitor Agents not logged section displays information on number of agents that are not 
logged in.
Agents Not Ready
Queue monitor Agents Not Ready section displays information on number of agents that are in not 
ready state.
Overview
Queue monitor Overview section displays information about number of Entered, Connected and 
Abandoned calls for specific queue for current day.
Callers
Queue monitor Callers section displays information about number of Total, Connected and Waiting 
callers for specific queue - realtime data.
Agents
Queue monitor Agents section displays information about total number of Agents in queue, as well 
as number of Logged in and Paused agents for specific queue - realtime data.
Extensions
Queue monitor Extensions section displays information total number of Static members and how 
many extensions is online for specific queue - realtime data.
Caller
You can filter your reports per specific caller number, allowing you to get even more precise 
information in your reports.
List of Agents/Extensions/Callers
Shows detailed information (Number, Name, Channel ID, Caller ID, etc.) about each agent, static 
member and caller with various options (monitor call, transfer call, hangup call)



QUEUE PANEL
Queue panel is a useful tool that will display a list of all available queues and general information about each queue (Agent status, number of Answered calls, 
Abandoned calls, etc) with option to show only total number for all queues and to show historical data rather than data for current day only.
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Calls
Queue Panel Calls section displays total number of calls serviced in the queue.
Answered
Queue Panel Answered section displays total number of answered calls.
Abandoned
Queue Panel Abandoned section displays total number of abandoned calls.
Waiting
Queue Panel Waiting section displays total number of the calls waiting in the queue.
Agents Idle
Queue Panel Agents Idle section displays number of currently idle Agents.
Agents Not Ready
Queue Panel Agents Not Ready section displays number of agents which are not ready.
Agents On Call
Queue Panel Agents On Call section displays number of agents currently on a call.

DIALER
Dialer allows lists of data to be loaded to a database and an application will run and dial these numbers based on an algorithm or settings entered by the admin. 
Dialer is mainly managed through Campaigns.
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Dialer Ring Strategy: Power
In the power strategy the campaign dials leads based on Idle agents multiplied with power number.
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Dialer Ring Strategy: Preview
This strategy gives an agent the ability to preview some details about a lead before it decides to dial 
them.
Dialer Ring Strategy: Progressive
This strategy works the same as a preview strategy, the only difference is that the agent has a 
certain timeout in which he/she must perform a dial.
Dialer Ring Strategy: Voice Messaging
This strategy automatically plays the message to leads. Additionally it records DTMF pressed during 
message.
Numbers
Option to import list of numbers to call via CSV files.
Number of Retries
How many time campaign will try to call one lead (one number imported via CSV file).
Force Trunk and Codec
Campaign can be forced to use only one Trunk and/or audio codec.
Agents
Agent can be member of only one campaign. Agents will not be able to use enhanced services when 
getting calls from dialer.
Retries No Answer/Busy/Abandon
Time in which the campaign will try to call again if current lead disposition is No Answer/Busy/
Abandon.
Answering Machine Detection
Posibility to enable and configure AMD. If this feature is on, for each lead answer, dialer will run 
AMD, to avoid connecting agent with answering machine.
Campaign Cycle
For power like strategies (Power and Voice Messaging), one can option to set number of seconds 
campaign will sleep bewteen cycles, maximum number of leads to call per cycle nad maximum 
number of concurrent leads campaign can have.
Caller ID
Option to choose which caller ID campaign will use.
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Dial Timeout
Time dialer will ring the lead.
Miminum digits to dial
A minimum number length allowed in order to dial numbers.
Don’t dial failed numbers again
If the numbers have failed for some reason, set the dialer not to dial them again.
Generate CDR
Option to enable/disable dialer to generate Asterisk CDR entries. Turning this feature ON is a 
performance penalty, and should be used only if you want to debug trunks.
Operation Times
This feature allows one to set working time for campaign, and applies only for power like strategies.
Dispositions
One can create list of dispositions that Agent will see in Communicator which can be applied at the 
end of the call.
Desktop App Integration
IP PBX Contact Center integration with desktop clients Communicator Agent and Communicator 
Supervisor will allow you to improve your employees performance by speeding up their workflow.
Stop Campaign(s)
Option to stop specific campaign or to stop all campaigns at once.



CAMPAIGNS MONITORING
Campaign monitor is a useful tool that will display information on Agent status (Loggend, Paused, Idle, Busy), and some basic campaign information (number of 
Dialling calls, number of Connecting calls, number of Connected calls), or one can select specific campaign to show detailed information about it.
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Calls Dialling
Campaign monitor Calls Connection section displays number of calls currently dialing.
Calls Connecting
Campaign monitor Calls Connection section displays number of calls currently connecting.
Calls Connected
Campaign monitor Calls Connected section displays number of calls currently connected.
Agents Logged
Campaign monitor Agents Logged section displays information on number of logged in agents.
Agents Paused
Campaign monitor Agents on Call section displays information about paused agents.
Agents Idle
Campaign monitor Agents Idle section displays information on number of idle agents.
Agents Busy
Campaign monitor Agents Busy section displays information on number of agents that are busy.
Contacts Total
Number of contacts made by agents on campaign.
Contacts Rate
Rate of contacts on campaign.
Overview
Campaign monitor Overview section displays information about number of Dialed, Unanswered, 
Connected and Abandoned calls for specific campaign for current day.
Leads
Campaign monitor Leads section displays information about number of Dialling, Connecting and 
Connected leads for specific campaign - realtime data.
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Agents
Campaign monitor Agents section displays information about total number of Agents in queue, as 
well as number of Logged in and Paused agents for specific campaign - realtime data.
List of Agents/Extensions/Callers
Shows detailed information (Number, Name, Channel ID, Lead, etc.) about each agent and lead with 
various options (monitor call, transfer call, hangup call).

DNC NUMBERS
DNC (Do not Call) Numbers contain a list of numbers not to be dialed by agents. You can upload your list by CSV. These numbers can be deleted from the list 
or added manually. Any DNC number marked by an agent trough disposition will be visible here also.

Multi-Tenant Business Contact Center
CSV Upload/Download
Option to upload/download list of numbers marked as DNC via csv file.

FEEDBACK FORM
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Customizable Feedback Forms
Creating custom feedback forms to be used with Communicator Agents in outbound (dialer) calls.



AGENTS
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Agent Types: Dynamic Agents
This type of agents can login with access code *202. The dynamic agent line is always opened, and 
he is listening Music on Hold when not serving customer calls.
Agent Types: Callback Agents
This type of agent can login  by dialing *203 access code. Callback agents phone will ring once they 
have call waiting to be served.
Group of Agents
To simplify queue members, management administrators can create groups of agents to easily add 
and remove multiple queue members.
NOTE: Agent Groups act as a template that allow you to move an entire group of agents into the queue 
but in case you add new group members into the group, they will not be automatically added to the 
queues you already added this group into prior to that moment.
Agent wrap-up time
Wrap-up time is a small time period in which agents will not receive the next call after they hang 
up a call. For example, if an agent finishes the call, you can assign a wrap-up time of 5000 ms (5 
seconds) to allow the agent to recover before a new call is forwarded to that agent.
Login with PIN
If set, agents must provide a personal PIN number in order to log in and start taking calls.
Pause Reason Codes
When an Agent needs to stop receiving the queue calls, but does not want to log out, they are able 
to use pause and stop receiving queue calls until they use un-pause option. Under these conditions 
they will still be reported as logged in to the queue(s). Now agents can provide a pause reason code 
to indicate the reason they are currently paused. This reason code is logged in with their pause 
event.
Auto Log Off
Time in seconds that the agent’s extension should ring before declaring them unavailable and 
logging them off.
Auto Pause
Automatically put agent on pause if they did not answer a call.
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Bind to Extension
Whether the system will bind the agent in question to the extension specified in the Extension field.
Direct IN
Agent calls received directly are tracked and logged. This is when agent is dialed directly using agent 
number and not extension. Those calls are reported as part of agents statistics.
Direct OUT
Agent calls made by direct dialing out are tracked and logged. Those calls are reported as part of 
agents statistics.
Project Codes
Agent can now make direct out call, and associate it with Project that is defined on server. Each 
Project can have defined different Caller ID, so when agent dials with that project, it will use caller 
id predefined.
Blending
Using desktop app integration agent can work in blending mode. That is system will switch agent 
inbound (queues) or outbound (campaign) depending based on queue requirements where he is 
member of.
Agents Realtime Statistics
Agents realtime statistics is useful tool that will display real time information about Agents on your 
system (answered and unanswered calls, talk time, idle time, sessions , pauses).
Calls
Number of total calls for agent, and number of answered and unanswered calls.
Talk Time
Total talk time, average talk time and average delay.
Idle time
Total idle time and average idle time.
Sessions
Total sessions time and number of sessions.
Pauses
Total pause time and number of pauses.



CONTACT CENTER STATISTICS
Statistics data will provide necessary tools that will help you to improve your contact center workflow and efficiency, detect bottlenecks and act in order to 
eliminate them. 
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Pre-Defined Date Ranges: Today
IP PBX statistics allows you to use predefined data statistics filter to display information for current 
day.
Pre-Defined Date Ranges: Yesterday
IP PBX statistics allows you to use predefined data statistics filter to display information for yesterday.
Pre-Defined Date Ranges: This Week
IP PBX statistics allows you to use predefined data statistics filter to display information for last 
seven days.
Pre-Defined Date Ranges: This Month
IP PBX statistics allows you to use predefined data statistics filter to display information for current 
month.
Pre-Defined Date Ranges: Last Month
IP PBX statistics allows you to use predefined data statistics filter to display information for last 
month.
Pre-Defined Date Ranges: This Year
IP PBX statistics allows you to use predefined data statistics filter to display information for last year.
Pre-Defined Date Ranges: Custom Date Range
IP PBX statistics allows you to use predefined data statistics filter to display information for custom 
date range.
Other Filters: Call Duration
Using Call Duration filter will allow you to get additional information based on call length.
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Other Filters: Hold Duration
Using Hold Duration filter will allow you to get additional information based on how long caller 
waited prior connecting.
Other Filters: Time Format
You can change the format of value for all time-related fields. Possible options are:
 
dd-hh-mm-ss    	 normal time format		  e.g    01d 02h 03m 04s 
Days			   time format in days     	 e.g    1.25d 
Hours       		  time format in hours      	 e.g    1.25h 
Minutes        		 time format in minutes	 e.g    1.25m 
Seconds        		 time format in seconds	 e.g    1.25s
Report Actions: PDF Download
This option allows you to download your reports in PDF format.
Report Actions: CSV Download
This option allows you to download your reports in CSV format.
Report Actions: Email
This option allows you to send your reports via E-mail. Report will be delivered in PDF format.
Report Actions: Print
This option allows you to print your reports from HTML page.
Report Actions: Graph
This option allows you to display graphs for your report.
Report Actions: More
This option allows to split you report into shorter date ranges.



AGENT STATISTICS
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Other Filters: Agents
You can filter your reports per specific agents, allowing you to get even more precise information in 
your reports.
Agent Reports: Agent Availability
Shows detailed information about agents. It provides a lot of information in a single report to give a 
quick overview of agent availability to the customer. The main feature here is agent idle time. This 
report focuses on all calls of agents, sessions, pauses and provides you with accurate information 
about agent idle time.
Agent Reports: Agent Calls per Direction
Shows a number of calls per direction. For each agent, the data is grouped per agent and then 
additionally grouped per direction ( direct in, direct out, inbound, outbound).
Agent Reports: Agent Direct IN Calls
Shows agents direct in calls. The main feature here is calls > 1m. Those calls should be looked like 
as effective calls. This value is configurable.
Agent Reports: Agent Direct OUT Calls
Shows detailed information about agents direct out calls. The main feature here are calls > 1m. 
Those calls should look like as effective calls. This value is configurable.
Agent Reports: Agent Direct OUT Calls per Project
Shows detailed information about agents direct out calls that were made with project codes. The 
data is grouped per agent, and for each agent the data is grouped per project code. Eg. If one agent 
made direct out calls with three different project codes, that will be also shown in statistics.
Agent Reports: Agent Occupancy
Shows detailed information about agent sessions, pauses, talk time and occupancy. The data is 
grouped per agent. Provides a lot of information in a single report to give the customer a quick 
overview of agent occupancy.
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Agent Reports: Agent Pauses
Shows number of agent pauses with/without reason, billable/payable pauses. The data is grouped 
per agent.
Agent Reports: Agent Sessions and Pauses
Shows information about agent sessions and pauses. The data is grouped per agent. The main 
feature here is a number of agent pauses per session.
Agent Reports: All Calls
Shows summary information about all agent calls. Includes all calls dispositions which contains the 
total number of calls, number of answered and unanswered calls.
Agent Reports: Direct OUT Answered Calls
Shows summary information about agent direct out answered calls. Includes direct out answered 
calls dispositions (agent hangups, caller hangups, transferred calls).
Agent Reports: Direct OUT Calls
Shows summary information about all direct out calls. Includes direct out calls dispositions which 
contains the total number of calls, the number of answered and unanswered calls.
Agent Reports: Direct OUT Unanswered Calls
Shows summary information about agent direct out unanswered calls. Includes direct out unanswered 
calls dispositions where users can see what was the reason for not answering (busy, no answer, 
cancel)
Agent Reports: Project Calls
Shows a number of calls made with some project code. The data is grouped per Project so the user 
can see how project codes are used. You can see here how calls are distributed per each project 
code.



DIALER STATISTICS
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Other Filters: Campaigns
You can filter your reports per specific campaigns, allowing you to get even more precise information 
in your reports.
Other Filters: Members
You can filter your reports per specific campaign members, allowing you to get even more precise 
information in your reports.
Other Filters: Lead
You can filter your reports per specific lead number, allowing you to get even more precise information 
in your reports.
Agent Reports: Agent Calls
Shows a detailed report about agent outbound calls. Data is grouped per agent.
Campaign Reports: Campaign All Calls
Shows detailed information about agent sessions, pauses, talk time and occupancy. The data is 
grouped per agent. Provides a lot of information in a single report to give the customer a quick 
overview of agent occupancy.
Campaign Reports: Campaign Calls per Disposition
Shows summary information about campaign all calls which include talk time, hold time and ring 
time. Data is grouped per campaign.
Summary Reports: Abandoned Calls Rate
Shows the number and percentage of abandoned calls.
Summary Reports: All Answered Calls
Shows summary information about all answered outbound calls. Includes all answered calls 
dispositions where we can see how did call finished (agent hangups, caller hangups, transferred).
Summary Reports: All Calls
Shows summary information about all outbound calls. Includes all calls dispositions which include 
the total number of calls, number of answered and unanswered calls.
Summary Reports: All Unanswered Calls
Shows summary information about all unanswered outbound calls. Includes all unanswered calls 
dispositions where we can see what was the reason for not answering (abandoned, machine, busy, 
noanswer, cancel).



QUEUE STATISTICS
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Other Filters: Queues
You can filter your reports per specific queues, allowing you to get even more precise information 
in your reports.
Other Filters: Members
You can filter your reports per specific queue members, allowing you to get even more precise 
information in your reports.
Other Filters: Caller
You can filter your reports per specific caller number, allowing you to get even more precise 
information in your reports.
Other Filters: DID
You can filter your reports per specific DID number, allowing you to get even more precise information 
in your reports.
Agent Reports: Agent Dumped Calls
Shows how many calls agent had dumped. Note that for one call, an agent can dump several times. 
Total is the number of calls agent had including calls that are dumped. This type of calls happen 
when agent hang up on the caller while the queue announcement (agent announce) was being 
played.
Agent Reports: Agent Inbound Calls
Shows information about agent inbound calls. Data is grouped per agent.
Agent Reports: Agent Inbound Calls per Queues
Shows detailed information about agent inbound calls. For each agent, data is grouped by queue. 
Users can see here how calls are distributed per agent per each queue.
Agent Reports: Agent Missed Calls
Shows agent missed calls, average of missed calls and total ring time. Important thing here is that 
we can have more than one missed call for one agent call in queue.
Queue Reports: Entry Positions
Shows average, min and max entry positions of the calls in the queue. Data is grouped per queue. 
This is a very important report because from this report we can find out how much load was in 
queues.
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Queue Reports: Queue Answered Calls
Shows more detailed information about queues answered calls. Data is grouped per queue. Includes 
answered calls dispositions where we can see how did call finished (agent hangups, caller hangups, 
transferred).
Queue Reports: Queue Callback Calls
Shows information about queues callback calls. Data is grouped per queue. Includes callback calls 
dispositions which contain the total number of callback calls, number of answered and unanswered 
calls.
Queue Reports: Queue Calls
Shows summary information about all queue calls. Data is grouped per queue. Includes Queue Calls 
Dispositions which contains the total number of calls, answered and unanswered calls.
Queue Reports: Queue Calls per Agents
Shows detailed information about queue calls per agent. Data is grouped per queue. For each 
queue, data is additionally grouped by an agent. You can see here how calls are distributed per 
queue per agent.
Queue Reports: Queue Unanswered Calls
Shows more detailed reports about queues unanswered calls. Data is grouped per queue. Includes 
unanswered calls dispositions where we can see what was the reason for not answering (abandon, 
exit with key, timed out).
Queue Reports: Repeated Callers
This report shows statistics of a caller who has called the queue at least two times.
Summary Reports: All Answered Calls
Shows summary information about all answered inbound calls. Includes all answered calls dispositions 
where we can see how did call finished (agent hangups, caller hangups, transferred).
Summary Reports: All Calls
Shows summary information about all inbound calls. Includes all call dispositions (Total, Answered, 
Unanswered).
Summary Reports: All Unanswered Calls
Shows summary information about all unanswered inbound calls. Includes unanswered calls 
dispositions where we can see what was the reason for not answering (Abandon, Exit With Key, 
Timeout).
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Summary Reports: Distributions for All Calls per Day
Shows all calls per each day. List of days depends on the time range filter.
Summary Reports: Distributions for All Calls per Day of Month
Shows you all calls for every 1st, 2nd day of month.
Summary Reports: Distributions for All Calls per Day of Week
Shows how the calls were distributed per day of the week.
Summary Reports: Distributions for All Calls per Hour
Shows how the calls were distributed per hour.
Summary Reports: Service Level Agreement
Service level agreement is calculated per each time range(10, 20, 30, 40 ,50, 60, 70, 80, 90, 100, 
110, 120) as: Service level = Answered calls inside time / Total answered calls * 100.
Summary Reports: Service Level Agreement Inclusive
Service level agreement inclusive is calculated per each time range(10, 20, 30, 40 ,50, 60, 70, 80, 
90, 100, 110, 120) as: Service level agreement inclusive = 100 - Answered calls inside time / Total 
all calls * 100.



VOICEMAIL
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Authentication with PIN
All users need to provide a PIN in order to authenticate when accessing their voicemail.
Voicemail to E-mail (Optional Attachment)
It is possible to enable all voicemail notifications to be sent to an e-mail address assigned to 
the extension. It is possible to select whether the voicemail message should be included in the 
attachment.
Custom Greeting Messages Depending on Status (Busy, Unavailable)
Users are able to record their personalized voice messages for “busy” and “unavailable” status, which 
will be played to callers depending on the current status of their extension.
Voicemail Operator Support
If enabled, callers are allowed to reach operators extension by pressing 0 once their call is forwarded 
to voicemail.
Timezone Support
Setting up matching time zone in extensions voicemail settings will make sure voicemail messages 
are played to users with the correct time information.
Sounds per Language
If sound files in a language other than English are uploaded to IP PBX alongside the default English 
language prompts, it is possible to set voicemail prompts to be played in the preferred language.
Limit Voicemail Length
This option will allow the administrator to define the maximum length of voicemail messages per 
mailbox, allowing you to limit space usage on servers with a large number of users.
Limit Voicemail Count
This option allow the administrator to define a maximum number of voicemail messages per mailbox, 
allowing you to limit space usage on servers with a large number of users.
Voicemail Groups
Voicemail groups allow you to group multiple voicemail inboxes to a group, informing all users once 
a voice message is left to their group.
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Message Waiting Indicator (MWI)
MWI option will inform the user that they have a voicemail message waiting in their mailbox by 
activating a new voicemail message indicator on their phone or Communicator desktop client.
Custom Greeting for a Voicemail Group
We have introduced an administrative option to upload a custom greeting for a voicemail group. 
Sound files can be uploaded via the Sounds section as previously. Sound files must begin with vm-
greeting-*.
Voicemail CSV Upload
Voicemail upload and Template download available on the Voicemail page. The template is: mailbox, 
name, pin, e-mail.
Speech to Text Ability to Specify Multiple Languages
This feature is located under: Settings > Voicemail > Show Advanced Options > Transcription. Speech 
to text ability to specify more than one language for transcription is available. Multiple languages are 
available only via the Google Speech service.
Voicemail Transcription on the Tenant and Extension Level
Under the Transcription options for the tenant the “Enable Transcription by Default” has been 
implemented. This option will determine if the transcription is enabled on all extensions for the 
tenant by default. 
Control of Voicemail Messages from Admin GUI
An administrator can view all voicemails from the selected voicemail box on the system. To view the 
voicemails go to: Home > Voicemail > Messages.
Custom Voicemail Login and Access
When creating a custom voicemail via Voicemail > Mailboxes > Add Voicemail, a “Password” field is 
added. This password together with the e-mail is used for the mailbox login. When logged in with 
this e-mail and password the user will only see the Voicemail Page.
Carbon Copy E-mails
On the Extensions page under the Voicemail section a field called “Carbon Copy E-mails” is available. 
“Carbon Copy E-mails” is used to add multiple recipients for e-mails, as BCC. The users can add 
multiple extensions in this field by typing them out and pressing Enter or the “Add xxxx” option 
displayed while typing.
Voicemail Lockout
If a user enters wrong pin for voicemail 3 times in a row, they will be locked out of the voicemail and 
the administrator will receive an email notification. These 3 failed attempts can be accross multiple 
calls.



MONITORING
The monitoring section allows the IP PBX administrator to monitor the status of main system extensions, trunks, conferences, queues and live channel in real 
time.
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System Extensions
Extensions panel in the Monitoring section will give you an overview of the current status of 
extensions, what user agents (device) are registered to the extensions, whether extensions are 
online or offline, and which extensions are on a call.
Trunks
The Trunks monitoring panel will display the trunks current status (online/offline) and the IP address 
of the remote system the trunk is registering to.
Conferences
The Conferences monitoring panel will display a list of available conferences, total activity time in 
the conference as well as a list of active conference members.
Queues
The Queues monitoring panel will display information on the Agent’s status (Unavailable, Idle, On 
call), statistics on queue calls etc.
Queue Panel
The Queue panel offers the same information as the Queue monitoring section, except the 
information in it is adapted for displaying on large screens.
Live Channels
The Live channels monitoring panel will display information on active channels and it will allow the 
administrator to monitor, transfer and hangup calls, as well as to see details on the selected live 
channel. 



SYSTEM EXTENSIONS AND TRUNKS WARNING SYSTEM
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Monitoring of SIP and IAX2 System Extensions
The Monitoring system can be set to monitor the status of SIP and IAX2 peers and if the status is 
changed it will trigger an offline warning notification.
Monitoring of Trunks via Outbound Test Number
In addition to monitoring the trunk status, it is possible to assign a Test number to each trunk. 
This number will be dialed in a predefined interval and if the number is unreachable, a warning 
notification will be triggered.
E-mail Notifications
If the IP PBX warning system is enabled, a notification will be sent to the assigned email addresses 
whenever the SIP or IAX2 peer goes offline or the Test number on the trunk is unreachable.

CDR REPORTS
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Linked ID for CDR’s
Filtering CDRs by linked ID will display all the CDRs that are “linked” to the selected one.
Control Access to Recordings
This feature provides control of who can access and manage call recordings, as well as the recording 
access history. This will ensure listening, downloading and deleting recordings is only available to 
authorized users.
CDR Search and Filters
The results will display as a call flow with the selected CDR included.
Listen and Download Call Recordings
Listen to call recordings for a specific call by locating a specific CDR and downloading the attached 
sound file.
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Call Recordings - Listen Recordings in-Browser
The IP PBX 5 interface now has a integrated call recordings player, allowing users to listen to IP PBX 
call recordings directly from their browser and navigate through the recording with a simple click of 
a mouse. This prevents the issue users might have experienced with earlier versions, as they had to 
find a media player that supports the format in which the recordings were being downloaded.
Delete Call Recordings
IP PBX allows you to delete call recordings from the Reports page.
Make Calls
You are able to initiate calls from the CDR page by selecting one record, picking up one of the call 
parties and entering the extension number you wish to use to make the call. The selected extension 
will ring and once you answer, the call to the destination chosen in the CDR page will be initiated.
Print Recordings
The print recordings option allows you to click the Print icon in order to print out the CDR records 
that are displayed on the current page. 
E-mail Recordings
The E-mail recordings option allows you to send a specific call recording by clicking the E-mail icon 
and entering the e-mail address you would like to send the CDR records to.
Information About Calls (CLIRs)
The CDR page offers additional call information for easier debugging. To see detailed information 
about the call, click Advanced icon, select the checkbox for the CDR in question and click the CLIR 
icon to open the popup window with the full call report.
CLIR for Exceed Channels
When the channels limit defined in the license is exceeded the CLIR will show the exact numbers 
(current > max). The notification email body will contain the same information.
CSV Download
Click this option in order to download the .CSV file which will include the CDR records based on 
your search.
Retention Policy
IP PBX’s retention policy for call recording files now goes up to 7 years now.
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Searching CDR by entering ‘anonymous’
This option enables to search reports by entering ‘anonymous’ in From field, to query the reports 
for Anonymous (inbound) calls

CDR STATISTICS
CDR statistics provides all the information related to the calls made on your IP PBX.
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Daily Statistics
Daily statistics displays the total number of calls per day for a selected date range.
Compare Data by Day / Month
The Compare section allows you to compare statistics per day/month range by selecting the Date 
range filter.
Calls Duration per Month
The Compare section allows you to check the call duration per month by selecting the month range 
filter.
Statistics per Extension
The extension section allows you to check the call statistics per extension.
Concurrent Calls Report
Ability to list the concurrent calls statistics per tenant / trunk.
Incoming Calls per DID
DID statistics filter calls per DID.



FILE SYSTEM CONTROLS
All IP PBX logs, sound recordings, CLI and CLIR files are stored on the local file system. Some of these files can grow to a size that will not leave any space on 
the system. This section provides management with information of how and when these files should be rotated or deleted in order to prevent such a scenario. 
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Set time for deletion of file sharing files
IP PBX admin sets time after files stored from file sharing will be deleted. Default value is 2 weeks.
LOG ROTATION
To prevent log files from growing too large and consuming all of the data on your IP PBX’s hard 
drive, data from the main log files are moved to another file after a certain period of time. 
Log rotation: Control of Log Rotation
Select how often you would like IP PBX log files to rotate. (default 2 weeks)
Log rotation: Other Log Files
The compare section allows you to check the call duration per month by selecting the month 
range filter.
FILES REMOVAL CONTROL
To prevent a number of large log files consuming all of the data on IP PBX’s drive, data that was 
moved from the main log files is deleted from the drive after a certain amount of time.
Files removal control: IP PBX CLIR Files
Select for how long you would like to preserve the IP PBX CLIR files. (default 2 weeks)
Files removal control: Asterisk Backup Files
Select for how long you would like to preserve Asterisk backup files. (default 2 weeks)
Files removal control: Control of Voicemail Removal
Select for how long you would like to preserve Voicemal messages. (default 2 weeks)
Files removal control: Control of Call Recordings Removal
Select for how long you would like to preserve IP PBX Call Recordings files. (default 2 weeks)
Files removal control: Control of FAX Files Removal
Select for how long you would like to preserve received FAX files. (default Never)
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System Optimization
System reload and memory usage on large system optimized.
System Files Upgraded
System upgraded to PHP 7, Rebuilds of binaries.

LOGS
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CLI Messages
In the event your system is experiencing some call issues, you can inspect the CLI messages log in 
order to get a better understanding of the problem.
SMTP Log
The SMTP log section will provide you with useful information on eventual issues with e-mail 
notifications and messages.

SOUNDS AND MUSIC ON HOLD
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Sounds Download / Upload and direct conversion of sound files
Easily upload, download and convert sound files from the IP PBX web interface or with the IP PBX 
Sound Converter desktop app.
Music on Hold Customization
In order to allow you to customize your system to your preference, Music on Hold classes can be 
easily assigned to queues, IVRs and even extensions. 
Music on Hold Options: Files Only, Grouped per Class
For easier management, sound files are grouped in MoH classes which can contain one or more 
sound files.
Music on Hold Options: MP3 Streaming
MoH MP3 streaming is set up by simply entering the link to a streaming MP3 sound file.
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Music on Hold Options: Random Playback
To avoid playing the same sound files to callers at all times, it is possible to add multiple sound files 
to a single MoH class and enable a random playback option. IP PBX will shuffle the order in which 
files are played to avoid monotonous playbacks.

ROUTING
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E.164 Routing
E.164 routing mode is using destination routes based on E.164 numbering rules. E.164 defines 
a general format for international telephone numbers. Plan-conforming numbers are limited to a 
maximum of 15 digits, excluding the international call prefix.
Simple Dial Plan Routing
Simple routing mode allows you to manually create preferred destination routes based on the 
number of digits dialed.
Disabled Routes
The Disabled Routes section allows you to enter specific destination routes in order to prevent 
callers from dialing the numbers that are part of those specific routes.
Special Routes
The Special Routes feature allows the IP PBX administrator to add special services numbers that 
will be distinguished from extensions numbers (even if they have the same number of digits) and 
dialed through the specified trunk, similar to how Emergency Services numbers are dialed through 
an Emergency Trunk.



LCR

LCR (Least Cost Routing) section allows fine-tuning of the system’s trunks usage accordingly to the price and quality.
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Setup Routing Up to Three Trunks per Destination Group
LCR allows you to setup up to three trunks to be used according to the cheapest price for each 
available route to lower the costs of calls for you and your customers.
LCR per System Extension
Mini LCR on extension enables you to override the system LCR and allow an extension to make calls 
through different trunks.

BILLING & SERVICE PLANS
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Billing Rates, Minimum Charge, Connection Charge, and Billing type per Destination Group
Billing rates can be set per Destination group, but to allow better billing customization, IP PBX also 
allows the setup of Minimum charge and Connection charge per destination group.
Time-Based Dialing
Time-based dialing allows an administrator to set up different billing prices for a specific time of the 
day. 
Minimum Charge
For easier management, sound files are grouped in MoH classes which can contain one or more 
sound file.
Connection Charge
Charges are applied to any call that leaves the system, regardless if the call was answerd or not.
Inclusive Minutes
Adding a number of Inclusive minutes to a Service Plan will enable callers to spend that time on calls 
to routes that have Inclusive minutes enabled, free of charge.
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Billing Increments
Assign specific billing increments to your Service Plan or route to fine-tune billing.
Option to Limit Service Plan for Tenants in “Tenant Packages” 
An administrator user will now be able to select which service plans are allowed for each tenant. 
This will allow the restriction of tenant users to only the plans allowed by the administrator.
Enhanced Services Template 
When creating a service plan, the default enhanced services can be selected, which will be available 
in OSC for the end user.
Change the word “Billing” with “Call Rating” 
Systemwide changed the word “Billing” with “Call Rating”.
Call Rating Cost in OSC and CDR 
Options button “Show Call Rating Cost in OSC”. When used on the extension it affects OSC and 
when used on a group it will affect all users that are in that group. If this option is set to “No” or is 
not checked then when looking at CDRs the Rating Cost column will not be shown.
LCR Page Visible on Master Tenant 
On Tenants it can set to use System Default LCR (the one on Master Tenant) or not. If Use System 
Default LCR is set to On then the configuration on that tenant will be ignored and the configuration 
on master tenant will be used. If it is set to Off then the configuration from that tenant will be used.

CRM INTEGRATION
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SugarCRM
IP PBX supports SugarCRM 6.5 and later.
SalesForce
IP PBX supports SalesForce CRM. 
Zendesk
IP PBX supports ZenDesk CRM.
Zoho
IP PBX supports Zoho CRM.
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Zoho
Added support for Zoho API v2
Microsoft Dynamics CRM
IP PBX supports Microsoft Dynamics 2015 CRM.
Bullhorn
IP PBX supports Bullhorn CRM.
Vtiger
Support for Vtiger CRM.
The SuiteCRM
Support for The SuiteCRM 
Pipedrive CRM
Support for Pipedrive CRM 
CRM Routing
CRM Routing allows routing to a specific queue or IVR, or playing sound files based on information 
fetched from the CRM. So, when the call comes in AGI, we will first contact the CRM and then 
based on the result, we will make a specific action. In the IP PBX Home tab we added a CRM menu 
with an Integration and Routing submenu. In the Routing submenu one can set up rules based on 
which call is to be routed. On DID and IVR we added new destinations where one can select the 
rule which will be evaluated for the particular DID/IVR.
SugarCRM
Added support for API v10+.
Hubspot
Support for Hubspot CRM.



E-MAILS
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E-mail Notifications Control
E-mail notifications control allows you to control which e-mail notifications will be sent to the 
administrator. 
E-mail Templates
E-mail templates allows you to edit the content of each E-mail notification message that is sent 
to users and administrators. The number of available variables enables you to provide information 
tailored to a specific user.
E-mail Template for Call Rating
A new email template for Call Rating was added to email templates.
Extension E-mail Templates per Tenant
Extension email templates per tenant will allow creating customized extension email templates for 
every tenant.
Proxy Value for Voicemail Templates
Variable %PROXY% is available for Email Templates. It references the value of Communicator SIP 
Proxy in the tenant / server settings.

GUI NOTIFICATIONS

GUI notifications warn users about license expiry date, new updates and status of emergency trunks setup in order to prevent potential system issues. 
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License Notifications
The IP PBX GUI now displays notifications on upcoming license expiry. The administrator will be 
informed both in web interface and by e-mail (on servers that have an SMTP server configured).
Update Notifications
Update notifications will be pushed to IP PBX GUI, notifying Administrators about new IP PBX 
releases and informing them of new features/bug fixes.
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Emergency Trunks Notification
On systems that do not have Emergency trunks assigned, a warning will be displayed in the 
notification bar, informing administrators of a potential issue.

DTMF ACCESS CODES

DTMF access codes allow IP PBX users to easily access and manage a number of IP PBX features.

Multi-Tenant Business Contact Center
Access Voicemail
The Voicemail box is accessed by dialing *123 on the phone that is connected to the user’s extension. 
In addition, to access the voicemail box from other extensions on IP PBX, users can dial *124 and 
then authorize with their personal extension number and PIN.
Voicemail Transfer
To transfer a call to an extension’s voicemail dial # *125 while on the active call, followed by the 
number of the extension you would like to transfer the call to.

Agents Login / Logout / Pause / Not Ready
IP PBX allows users to enter a range of access codes to log in/out agents, pause them or put them 
in a not ready state.
Instant Call Recordings
When enabled in enhanced services users can start call recording at any point in a live call by dialing 
*159.
Pause/Unpause Call Recording
To pause a call recording, while on an active call, users can dial *9. This is useful for situations where 
the customer is providing personal data like a credit card number. Once they are done, in order to 
continue the call recording users can dial *91.
Start Monitoring a Call
Users with Call Monitoring enabled, in extensions enhanced services, are able to listen to active 
conversations by dialing *199 followed by the number of the extension they would want to monitor, 
while that extension is on the call.
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Paging
Users can dial *399 to relay a voice message to a predefined set of extensions. To page a single 
extension, users have to dial *400 followed by the number of the extension they would like to page. 
Some phones require additional setup in order for speakerphone to activate automatically when the 
device is paged.
Paging a Group Through Speakerphone
Dial *600 followed by the number of the paging group you would like to page in order to broadcast 
the message over the speakerphone of extensions that are members of this paging group.
Speed Dial
Dial *130 followed by the short code assigned to the number you frequently dial in order to initiate 
speed dial to a specified number.
Select Other Networks
Other network features allow you to force calls to go through a specific trunk by entering an assigned 
number that can be 1-3 digits in length. If the Other Networks option is set up to be used with 
numbers longer than 1-digit, access code *188 must be entered before the assigned number and 
this is followed by the number the caller wishes to dial. For example, if you assigned 231 as an Other 
Network number for Trunk D, to force the call to go out through that trunk you must dial *188 231 
followed by the number you wish to call.
Listen to CDR Recordings
Access code *170 is used when the user want to listen to the last 9 Call Recordings from the CDRs 
page. For example the user can dial *170 from their phone followed by a number between 1 and 9, 
where 1 is the most recent recorded conversation.
Toggle Call Forwarding
Dial *71 on your extension to enable the call forwarding rules predefined in the extension’s enhanced 
services. To disable call forwarding dial *72.
Toggle Group Hunt
Dial *510 on your extension to enable the Group Hunt rules predefined in the extension’s enhanced 
services. To disable the Group Hunt rules, dial *511.
Block Your Caller ID
You are able to block your Caller ID by entering *67. Blocking will be in effect until you use *68 to 
unblock your caller ID. If you would like to temporary block your caller ID, dial *81 to block it for 
only the next call.
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Call with CallerID
If an extension has a list of Allowed CallerIDs set, users can use access code *65 to use one of the 
available caller IDs to make a temporary change of caller ID. Although this feature is meant to be 
used with Communicator, we have made it available to use over your desk phone. 
Toggle Follow Me Rules
Dial *520 on your extension to enable the Follow Me rules predefined in the extension’s enhanced 
services. To disable the Follow Me rules dial *521.
Call Parking
If you would like to park a call to available parking slots, dial *700 while on the call. The system will 
play notifications to what parking slot number your call was parked. The default parking slot range 
span starts at 701 and ends at 720. This can be changed from Settings -> Access Codes page.
Direct Call Parking
The voicemail box is accessed by dialing *123 on a phone connected to the user’s extension. In 
addition, to access the voicemail box from other extensions on IP PBX, users can dial *124 and then 
authorize with their personal extension number and PIN.
Enhanced Call Parking
While on an active call you can dial ‘#800’. The call will be parked and the Announce Extension 
will ring for a set number of seconds. After that period, the call will be directed to the Timeout 
Extension. Timeout, Announce Extension and Timeout extension must be set under Settings -> 
Servers/Tenants -> Master Tenant/TenantName -> Enhanced Call Parking (section).
Test Music on Hold
To perform a system test for the default music on hold class, dial *388 from your extension. If 
everything is okay, you should be able to hear your MoH class playing without any issues. 
Echo Audio Read
Users can dial ‘*398’ and talk into the phone. Everything they say will be played back to them to 
allow them to check the server response time.
Record Greetings
Dial *301 on your extension to record greeting messages from your phone. Greeting messages 
recorded this way can be found in the Sound files section under the letter G and will be named 
greeting-DATE-TIME. Rename them to the required format to use them with other IP PBX elements.
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Toggle Operation Times
Use *401 on your extension to open your system’s operation times or *402 to close it. The extension 
must have the Operation Time option enabled in extensions Enhanced Services.
Reset Operation Times
Users can dial *403 to reset the Operation Time rules. Before, they had to open them in order to 
allow calls to come in after closed time. In order to use this feature, Operation times must be closed 
first using *402.
Hot Desking
Users can dial *555 in order to log in or log out of their hot desking extension.
Customizable Access Codes for Call Pickup
1. Under Settings > Access codes, added codes for call pickup using *8 and *88+EXT_NUM 
2. Under Extension > Enhanced Services added codes for call pickup using *8 and *88+EXT_NUM 
next to the Call Pickup.
Toggle for the Do Not Disturb Feature
Implemented an Access Code as a toggle for the “Do Not Disturb” feature. The default value is *77. 
This Access Code can be used as a BLF in the BLF/Directory list by adding *77XXX, where XXX 
is the extension number. When used as a BLF, the button will also switch colors when DND is 
enabled/disabled.
Voicemail transfer between tenants
During an active conversation users can dial ‘*125 + $TENANT + $EXTENSION’ to transfer the
calling party to a system $EXTENSION number voice box.
Greeting access code for specific destination type (IVR, Ring Group etc)
Change Greeting: defaults to *303 and takes a queue/IVR or ring group as destination. When 
dialed the user is prompted to record a new greeting. Once accepted the greeting is set as the 
destinations new greeting. Change Greeting: defaults to *304 and  takes a queue/IVR or ring group 
as destination. 
Toggle Operation Times
Dialing *405 will toggle *402 / *403 access codes.
Transfer call to voicemail on different tenant
Redirect an ongoing call to a voicemail on a different tenant by dialing *125 + tenant extension.



FAX
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SIP T.38 Support
IP PBX supports T.38 standard for faxing over SIP.
Sending Faxes
IP PBX supports sending of FAXes using the Communicator desktop app.
Receiving Faxes (E-mail)
Fax to E-mail option on IP PBX allows you to receive faxes in digital form and to automatically send 
them to a specified e-mail address. Received FAXes will stay preserved on the server as well. In 
addition, it is possible to connect a FAX machine to an ATA device in order to receive FAXes in a 
conventional manner.
Viewing Faxes in TIFF / PDF Format
In the FAX section of the IP PBX GUI you can see a list of FAXes received through the Fax to E-mail 
feature. You can download them in a TIFF or PDF format and view them on your computer.
FAX Cover Page Customization
IP PBX allows you to set general FAX settings for a fax cover page which will be applied on every 
fax that is sent from IP PBX. Additional options are available in the Communicator desktop client.
Sending Faxes Between IP PBX Instances (Remote FAX Functionality)
This option allows you to configure IP PBX to transfer all incoming faxes to a remote system.
FAX Caller ID
Choose a CallerID when sending a fax from a list of predefined caller IDs. Communicator users can 
choose different caller IDs, from a predefined list in the IP PBX GUI, for sending a FAX.
Email to Fax
This is a service that allows people to send faxes via e-mail. An e-mail can have multiple files attached 
but there is a configurable limit on those files, the default is a maximum of 5 files per e-mail. E-mail 
To Fax must be enabled on the license
Allow Caller ID Option to have both name and number
This option enables to set both caller id name and caller id number for Email to Fax Caller ID.
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Requeue Timeout
This option defines the number of seconds after which a failed Fax try will be requeued.
Choose Trunks to use
Set the primary, secondary and tertiary trunk for Email to Fax feature. These trunks would then 
override the trunks set on tenant/server level.
Email Addresses Whitelist
Whitelist which email addresses can use Email to Fax feature.

GUI GLOBAL SETTINGS

The IP PBX graphical interface allows you to configure and supervise your PBX faster, easier, and much more efficient than any other product on the market. 
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Global Administrators
Besides the main administrative accounts, IP PBX GUI allows the creation of additional 
administrator accounts so users do not have to share a single account. 
Site / Tenant Administrators
To give customers management over settings on rented tenants, an administrator can create lower 
level administrator accounts with tenant level administrative privileges.
Action Logs
The Action Logs feature will provide information on what changes are made, who made them and 
when. It can also help you detect unauthorized access by storing information of IP addresses from 
which the connection to your IP PBX was established.
Different Action Log for “Download” and “Listen” Actions
Separated logs for CDR Download and Listen actions. Logs are available for CDR Download and 
Listen actions. These can be found under Admin Settings > Action Logs.
Admins/Users Permission to Create Tenants
Grant admins/users permission to create tenants along with other permissions. Full administrator 
access will not be granted but they will be able to create tenants.
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Date/Time Format Settings
IP PBX GUI allows you to Set/Change the date and time format settings according to your location.
Timezone per Tenant, Timezone per Extension
Setup a default timezone for a tenant that will apply to all extensions on that tenant. There is a new 
option to change the time zone for only an extension. This option will enable usage of one multi-
tenant in different time zones. 
Language Settings (Internationalization Support)
IP PBX GUI is already translated to several languages but in case your language is not available, we 
will provide you with translation files which will allow you to translate IP PBX GUI to your preferred 
language.
New Language Added
French language translation added for GUI.
Tenant groups
A user can create one or more tenant to tenant call groups with a list of tenants who are allowed to 
call each other. Tenants and packages together with Call Groups are in the sub menu of the Tenant’s 
menu items. On the Tenant Add/Edit page option, “Disable Tenant to Tenant calls” was renamed 
to “Enable Tenant to Tenant calls”. To choose the tenant to tenant calls group (Field label “Tenant 
to Tenant calls groups”), when selecting/changing a group, the tenant will be automatically added/
removed to/from the group. If no group is selected, tenant calls will be allowed for all tenants.
E-mail Sender per Tenant
On the Tenant Add/Edit page, options to customize e-mail sender per tenant is added.
Send E-mail in Case Special Number is Dialed
Server/Tenant Edit - > Emergency Services button. A new field called Notification E-mail. When set 
on something that is not Master Tenant ( CC or Tenant ) after dialing one of the emergency numbers, 
an e-mail will be sent to the provided address. If the e-mail field is left empty, no e-mail will be sent. 
Note that setting this on Master Tenant will not affect others. In E-mail Templates there is a new 
template called ‘Emergency Call Template’.
HTTP API
IP PBX API is a service that provides easy access to IP PBX features and data over HTTP.
IP Address Restrictions (Blacklist/Whitelist)
It is possible to restrict access to IP PBX GUI by either adding IP addresses to a blacklist to restrict 
their access or by creating a whitelist which will only allow access to specified IP addresses. 
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LDAP Integration
IP PBX now allows LDAP integration, which allows users with an Active Directory or openLDAP 
account to authenticate to IP PBX using their LDAP credentials.
Branding
Branding allows you to customize IP PBX GUI with your company logos and/or colors.
Simple Branding for Online Self Care
This offers a possibility to brand the Online Self Care including the logo change. 
Location of the feature is: Admin settings > Branding > Online Self Care.
Sessions
To prevent unauthorized access to the IP PBX web interface we created an automatic account 
suspension feature. By default, accounts will be suspended after 5 unsuccessful login attempts in 1 
minute but users can change these values to match their preferences. After an account is suspended 
it will have to be unlocked by the administrator.
CDR Extension Limit - Advanced Options
A drop-down is added on the “Allow CDR extensions field” in user groups which will expand this 
field’s functionality.
1.	 Including > All CDRs that include the selected extensions can be shown.
2.	 Between > Only calls BETWEEN the selected extensions can be shown.
3.	 From > Only calls made FROM the selected extensions can be shown.
4.	 To > Only calls made TO the selected extensions can be shown.
Speed Dial Settings can be Managed per Tenant
The Speed Dial page is available per tenant - Tenant > Settings > Speed Dial. 
The Speed dial page was available only on Master tenant before.
Prevent users from deleting call recordings
Prevent users from deleting call recordings.



BRANDING
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Simple Branding
The simple branding feature allows users to easily upload their custom logo and change the interface 
colors from IP PBX GUI by simply clicking the mouse.
Custom CSS Branding
Advanced users are able to modify CSS files to visually adapt IP PBX GUI to their preference. 
Custom Login logo
Your company logo can be uploaded to be displayed on the IP PBX login page.
Product Name Branding
We are offering an option to change the “IP PBX” name to match our customer’s preferences. For 
more information please contact your account manager.

GUI TOOLS
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In-browser Asterisk CLI
To make it easier for our customers that do not have as much experience working in a terminal 
environment, IP PBX 5 has an integrated Asterisk CLI monitor in its interface. The Asterisk CLI is 
accessible on main administrative accounts on IP PBX and does not require a root password to 
access it. While this may sound like a potential security issue, we have prevented problems by 
allowing the execution of monitoring commands only when using the in-browser Asterisk CLI. Apart 
from permissions being limited, you will be able to use debugging and other monitoring features the 
same as if you were logged in to the Asterisk CLI from the shell.
SMTP Log
E-mail notifications are a useful tool for IP PBX administrators as well as end users. By providing 
automatic reports on system status and issues or automatically emailing access details when new 
users are created, administrators will be relieved of the additional workload. At the same time, the 
end user experience is improved through the use of different e-mail notifications. In 5.0 we made 
things even better with a SMTP Log that is built-in to the IP PBX interface, allowing easy  debugging 
in cases where e-mails are not delivered. To see the issue, simply navigate to Reports → SMTP Log, 
from the Home tab of IP PBX settings.



SUPPORTED BROWSERS (GUI)
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Internet Explorer 10+
IP PBX GUI supports the Internet Explorer version 10 and later.
Safari
IP PBX GUI supports the Safari web browser.
Google Chrome
IP PBX GUI supports the Google Chrome web browser.
Firefox
IP PBX GUI supports the Firefox web browser.

HTTP API
In general terms, API is a set of clearly defined methods of communication between software components, or in our case between IP PBX and custom solutions 
developed for working with IP PBX.
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Extensions
You can add, edit, configure, delete or list IP PBX extensions through API queries. In addition to 
these options it is possible to manage extension billing through API.
Trunks
API queries can be used to list Trunks available on IP PBX.
Trunks Extended API
Trunks: Add, Edit, Delete, Tenant actions.
DIDs
It is possible to add, edit, delete or list IP PBX DIDs through API queries.
DID Groups
API queries can be used to add, edit, delete or list DID groups on IP PBX 5.0 MT
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Ring Groups
It is possible to add, edit, delete or list IP PBX Ring groups through API queries.
IVRs
It is possible to add, edit, delete or list IP PBX IVRs through API queries.
CDRs
It is possible to download CDRs and get information on billing amounts through API requests.
Routes
It is possible to list available IP PBX Routes using API queries.
Servers
On the Bussines and Call Center edition you can use API queries to get server configuration details.
Enhanced Services
Enhanced Services API update, all enhanced services are exposed in new APIs.
Tenants
On the MT edition It is possible to add, edit, delete or list IP PBX Tenants through API queries.
Service Plans
API queries can be used to list available service plans and list prices for available destination groups.
Destinations
API queries can be used to list available destinations and destination groups.
Print the API doc from within IP PBX
Print the API doc right from IP PBX.
Advanced API keys management
Advanced API keys management allows: Multiple API keys, Defining allowed actions per key, Which 
tenant ID can be accessed, Limit API key access per IP address (or address range), Add API key 
expiry, Add information about last access of API key, browser, IP address.



SETUP WIZARD
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Timezone Configuration
In this part of the setup wizard, the administrator is able to set up or change the default time zone 
on IP PBX.
Administrator Password
The IP PBX setup wizard will allow you to create/change the main administrator username and 
password.
Licensing
The licensing section allows the administrator to apply new or reapply updated IP PBX license when 
needed.
Services control
From the Services control section, an administrator can stop, start or restart server services like PBX 
service, IP PBX, HTTP service, Database service etc.
SMTP Configuration
Configure your IP PBX with an e-mail account in order to send out notification e-mails to users and 
administrators.
G.729 Codec and License Installation
The G.729 section of the IP PBX setup wizard allows you to easily apply G.729 codec licenses to 
your IP PBX.
Updates and Upgrades
You can easily update or upgrade your IP PBX server from the Updates section. This feature only 
allows updates between minor versions like 4.1 to 4.1.2 while major versions upgrades, 4.0 to 5.0 
for example, can only be performed by our trained staff members.
Remote Logs
Remote logs feature allow you to connect your IP PBX to remote MySQL database in order to store 
CDR database on remote server. Please note that if this feature is enabled, in case connection 
to database server is interrupted, you will not be able to access CDR data until connection is 
reestablished.
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SSL Certificate import
Setup wizard allows you to create and download your IP PBXs private key and CSR files in order to 
send them to certificate authorities. In addition, once you receive your certificate files you can use 
this tool to install it on your IP PBX.
SSL Certificate Integration with Let’s Encrypt
With the Let’s Encrypt integration in IP PBX 5 our users will not have to worry about when their 
SSL certificate is about to expire as IP PBX and the Let’s Encrypt service will renew the certificate 
every 90 days automatically without any need for user interaction.
Let’s Encrypt is a free, automated, and open Certificate Authority used for setting up an HTTPS 
server and having it automatically obtain a browser-trusted certificate, without any human 
intervention (https://letsencrypt.org/).
This means the customer will need to install the certificate only once and it will be automatically 
renewed once it is about to expire.
Backup
Manually initiate IP PBX backup or set up a backup to run daily by selecting an option in the 
Backup section. It is possible to exclude Recordings, Voicemails, CLIR files and/or Log files in order 
to preserve space.
QoS
If you are experiencing call quality issues because of high network load, you can set tag VoIP 
packets based on your preferred QoS settings.
Progress bar in Setup Wizard
Progress bar in Setup Wizard is added to show info about updates on tables.



AUTO PROVISIONING
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HTTP/HTTPS Provisioning with Authentication
IP PBX supports HTTP/HTTPS provisioning with Polycom, Yealink, Cisco SPA, Panasonic and Obihai 
devices.
TFTP Provisioning
IP PBX supports TFTP provisioning on all devices.
TFTP Provisioning Enable/Disable
TFTP startup can be controlled  in GUI (Master Server / Master Tenant).
Exposing variables in Additional config

SUPPORTED DEVICES
A wide range of supported UADs is an advantage IP PBX is providing for its users. With suport for all major brands in the industry we also offer support for range 
of devices not as widely supported on other platforms.
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Phones: Aastra
Supported Aastra models: 480i, 53i, 55i, 57i, 9112i, 9133i.
Phones: Alcatel
Supported Alcatel models: IP100, IP150, IP200, IP300, IP600, IP800, IP1020, IP2015.
Phones: Grandstream
Supported Grandstream models: BT-102, BT-101, GXP-2000, GXP-2124, GXP-2160, GXW-4004, 
GXP1625, GXP1628, GXP1630, GXP1782, GXP2170, GXV3275, GXP2130, GXP2135, GXP1615, 
GXP1760W, GXP2140, GRP2612, GRP2613, GRP2614, GRP2615, GRP2616.
Phones: Gigaset
Supported Gigaset models: Maxwell Basic, Maxwell 2, Maxwell 3, Maxwell 10, N720, N510, N870.
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Phones: Cisco
Supported Cisco models: 7940, 7941G, 7942G, 7945G, 7960, 7961G, 7962G, 7965G, 7971G, 
7975G, 8851, 7821, 8841, 6851, 8865.
WARNING: Cisco 79xx devices, other than 7940 and 7960, will not work if IP PBX is not in the same LAN.
Phones: Cisco SPA
Supported Cisco SPA models: SPA301, SPA901, SPA501G, SPA502G, SPA504G, SPA508G, 
SPA509G, SPA525G2.
Phones: Denwa
Supported Denwa models: DW-210P, DW-310P, DW-610P.
Phones: Fanvil
Supported Fanvil models: X4, H3, H5, X2P, X3G, X3S, X4G, X5S, X6.
Phones: Hanlong
Supported Hanlong models: UC902P, UC903, UC923, UC924, UC926
Phones: Htek
Supported Htek models: UC802P, UC803P, UC804P, UC806P, UC840P, UC842, UC860P, UC862, 
UC912P, UC912G, UC924E, UC926E.
Phones: Huawei
Supported Huawei models: eSpace 7910, eSpace 7950.
Phones: Mitel
Supported Mitel models: 6867i.
Phones: Panasonic
Supported Panasonic models: KX-HDV130, KX-UT113, KX-UT123, KX-UT133, KX-UT136, KX-
TGP550, KX-UTG300B.
Phones: Linksys
Supported Linksys models: SPA-941, SPA-942, SPA-962
Phones: Obihai
Supported Obihai models: OBi110, OBi202, OBi302, OBi504, OBi508, OBi1022, OBi1032, 
OBi1062
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Phones: Polycom
Supported Polycom models: IP301, IP320, IP321, IP330, IP331, IP335, IP450, IP501, IP550, IP560, 
IP601, IP650, IP670, IP5000, VVX101, VVX201, VVX300, VVX310, VVX400, VVX410, VVX500, 
VVX600, VVX1500, VVX150, VVX250, VVX350, VVX450, VVX411, VVX501, VVX x50 OBi Edition, 
VVX601.
Phones: Sangoma
Supported Sangoma models: S500, S505, S700, S705.
Phones: Snom
Supported Snom models: 320, 360, 190, D315, D345, D375, D715, D745, D765, D785, D735, 
D717, D120.
Phones: Vtech
Supported Vtech models: VCS754, VSP600, VSP715, VSP726, VSP736, VSP725, VSP735, VSP716A, 
VSP726A, VSP736A, VDP650, ET605, ET617, ET635, ET685.
Phones: Yealink
Supported Yealink models: T18P, T19P, T20P, T21PE2, T22P, T23G, T26P, T27P, T28P, T29G, T32P, 
T38P, T41, T41S, T42G, T42S, T46G, T48G, T48S, T49G, T58V, W52P, W56P, CP860, T60P, T65P, 
CP920, CP960, T40G, T52S, T64S, T56A, W60B, W53H, T53W, T53, T54W, CP930W, W80B, 
VP59, T57W.
ATAs: Grandstream
Supported Grandstream ATA models: HT-286, HT-386, HT-486, HT-488, HT-496, HT-502, HT-
503, HT-701, HT-702, HT-704, HT-814.
ATAs: Cisco
Supported Cisco ATA models: SPA112.
ATAs: Linksys
Supported Linksys ATA models: PAP2.
ATAs: Obihai
Supported Obihai ATA models: OBi302, OBi110, OBi202, OBi300, OBi302, OBi504, OBi508.
ATAs: Sipura
Supported Sipura ATA models: SPA-841, SPA-1000, SPA-2000, SPA-3000.
ATAs: ReadyNet 
Supported ReadyNet ATA models: AC1200MS, AC1000MS, AC1100MSF, QX300.
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UAD Settings on Master Tenant
This extends the ability to set specific settings on the Master tenant for UADs. These settings are 
inherited when creating tenants.
EOL Devices list
End of life devices will be shown and flagged in UAD list.

CNAM INTEGRATION
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CNAM Lookup
When phone calls are made, there are usually two user-facing identifiable pieces of information: 
a phone number and a Caller ID Name. CNAM can be used to display the calling party’s name 
alongside the phone number, to help users easily identify a caller. There are numerous CNAM 
lookup services which allow you to pay a small fee to lookup the CNAM of a specified caller and IP 
PBX now allows you to integrate with them.
Support for CNAM providers with Text/Plain Response Type
Added support for CNAM providers which return plain text instead of just a response.

ARCHIVING STORAGE
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Archiving  Storage with FTP, Amazon S3 and Dropbox
IP PBX 5.0 includes the archiving storage feature that can be used to keep your recordings, 
voicemails, and FAXes on a remote location. You can choose between three options for remote 
storage: Amazon S3, FTP server, or Dropbox. You can either keep these files on both your IP PBX 
server and the remote server for backup purposes, or set files to be removed after the upload to 
preserve space on IP PBX.
Rename to Archiving Storage
Formerly known as “Remote storage” is “Archiving storage”.
Google Drive Support
Customers can use Google Drive for archiving storage.
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Archiving Storage Optimization
Control of MP3 conversion, upload rate control, upload retries and email notification are exposed 
in GUI.
1.	 Added option for control over MP3 conversion in IP PBX GUI for archiving storage. This way 

users can choose either to compress uploaded recordings or leave them in native format.
2.	 The “Upload Rate” field is exposed in the GUI for users, this way users can manage the upload 

rate to avoid network issues if necessary.
3.	 The “Max Retries” field is exposed in the GUI for users to enter the maximum number of upload 

retries for  a single file in a case of a network error.
4.	 Added E-mail Notifications for failed uploads.
Archiving Storage, Schedule Archiving
A scheduling option was introduced to the Archiving storage on the master tenant/server. Users can 
select the frequency in which the archiving storage daemon will execute data offload.
Access Recordings from GUI (S3/Google Drive)
This feature enables customers to listen to the remotely stored recordings from the GUI as well as 
to download them. Recordings are streamed directly to the client and no local files are created on 
the system during the feature’s use. There is a new option in the CDR GUI age which replaces the 
listen button for a specific CDR which represents the option to listen to the remotely stored record 
and is indicated by the service the record is stored on.
Bandwidth Control
To prevent Archiving Storage data uploads making a negative impact to your network performance, 
IP PBX enables you to easily restrict the maximum upload speed, by entering the number of KB/s 
which will be used for the upload to archiving storage servers. Data is by default synced once a 
week.
Remove Files
When enabled, the Remove files option will delete the data on IP PBX after the transfer to the 
archiving storage server is successfully completed.
Reports Page
The Reports page for Archiving Storage is located under Home -> System -> Storage in your IP 
PBX GUI. Here you will be able to see whether the transfer was succesful or failed, along with 
information on the number of recordings, voicemails and FAXes that were uploaded to the archiving 
storage location.



TENANTS / SERVERS
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Not Active tenant status
When set to not active, extensions can not be reached and the tenant is not available in the 
dropdown.
Suspended tenant status
When set to suspended, extensions can be dialed, but they can not make calls. 
Notification when an emergency service is called
When 911 is dialed, an automated call goes out to a specified number or extension or ring group, 
playing an announcement that 911 was dialed from this extension. This can be done in ring all or 
ring single strategy.
Set maximum file size for file sharing
IP PBX admin sets maximum size of file that can be sent with file sharing. Value can be set between 
25MB and 250MB, default value is 50MB.



MEETINGS
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Meetings List: Scheduled
This list shows all Meetings that will be held in the future.
Meetings List: Recent
This list shows all Meetings that have already been held.
Meetings List: Date Range
This list shows all Meetings for the period selected beginning from the Start Date and finishing with 
the End Date.
Meeting Details: Status
Shows the Meeting’s status.
Meeting Details: Date/Time
Date and Time showing if the Meeting will take place or it has been held.
Meeting Details: Duration
Time duration of a Meeting.
Meeting Details: Organizer
Name of the Meeting’s organizer and his/her Extension.
Meeting Details: List of Participants
Shows Name and Extension of every Meeting’s participant.
Meeting Details: List of DIDs
All DIDs in the Meeting.
View Base Meeting
The button ‘View base meeting’ is visible only if a Meeting is recurrent. By pressing it, further 
information on Base Meeting becomes accessible.
View Base Meeting: Meeting Details
Users may click the button ‘Meeting details’ if they want to return to the “Meeting Details” page as 
presented on the screenshot.



MEETING SETTINGS
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Daily digest: Time Zone
Preferable Time zone.
Daily digest: Use Custom Settings
If this option is off, any settings set on the system will be used.
Daily digest: Week Days
Specifies days in a week when e-mails will be sent.
Daily digest: Daily digest time
Time of receiving daily e-mails.

TOUCHLESS PROVISIONING
Feature that allows simple and fast phone provisioning. Allows the administrators to register the phones to provider’s redirection services. After the phone is 
registered it needs to be factory reset and it will be provisioned automatically. No changes in the Phone’s User Interface are needed.
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Support for Yealink Phones
Acquire an RPS account from the Yealink support and find the API AccessKeyID and AccessKeySecret. 
Enter those values in the User Interface and Yealink phones are ready for use with the Touchless 
Provisioning Feature.
Touchless Provisioning Mode
Set where touchless provisioning can be configured, only on Master Tenant or Per Tenant.
Touchless Provisioning Devices
A page where it is possible to see all devices that can use the touchless provisioning feature.
Touchless Provisioning Reports
All requests and their results to the provider’s redirecting services can be seen under Reports > 
Touchless provisioning.



CENTRAL PHONE BOOK
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Define a Global Phone Book
IP PBX admins can add contacts to a global Phone Book which will be sent to Communicator and 
to some phone models. Supported models as Yealink, Polycom and Cisco. To enable phone book for 
phones you need to enable LDAP option on Servers/Tenants > Edit page.
Define an Extension specific Phone Book
Phone Book contacts can also be added per extension. Contacts added here will be sent together 
with the global contacts to the extension. Only the extensions where these contacts are defined will 
see the contacts. Users can also manage their contacts through OSC.
CSV Upload/Download
Upload Contacts using CSV or download existing contacts in a CSV format. When uploading a 
CSV all existing contacts will be removed (Only the contacts in the CSV file will be visible after the 
upload).

OTHER FEATURES
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Enable Jitterbuffer Based on Extension and Tenant Configuration
jitterbuffer on Extension. Jitterbuffer type:
1.	 Fixed - Set a fixed jitterbuffer on the channel.
2.	 Adaptive - Set an adaptive jitterbuffer on the channel.
3.	 Disabled - Remove a previously set jitterbuffer from the channel.
Simplified Mobile App Licensing
Users are able to see the mobile devices available on the system as one group of mobile devices. 
Both “iOS” and “Android” options are merged as a single “Mobile Apps” option. This way the customer 
buys “Mobile Apps” subscriptions and connects the mobile apps regardless of the platform.
Hide Extension in Desktop/Mobile Apps
The option to enable/disable non-Communicator extensions from displaying in Communicator. This 
was added on the IP PBX extension so the system admin can manage (enable/disable) this option 
directly from the IP PBX GUI.
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Allow IP Address Authentication for Extensions
New field per tenant - Allows IP Address Authentication for Extensions and forces an IP-based 
authentication. If the option is disabled, the following fields on the extension will be hidden: 
“Incoming IP Addresses” and “Insecure”.
Renamed “Number of Digits” to “Extensions Digit Length”
In the setup wizard and in the option to create a new tenant “Number of digits” is changed to 
“Extension digit length” to avoid problems.
Configurable Features Permissions
Separate permissions are available for chat, voicemail, osc, agent pause, access codes, qos, directory 
and phone DND. Permissions are set per tenant and edition in IP PBX.
Control of MP3 Conversion
System settings option for audio conversion. 
Convert files to mp3, this will apply to system-wide recordings 
Select options from the drop-down: 
Convert and remove original 
Convert and listen / download 
Convert and keep original 
Do not convert 
Will leave files in the original format without conversion (recordings can’t be played from GUI).
Keyboard Friendly Controls
Using the tab key, users are able to access all links and controls in a predictable order based on their 
visual position on the page. User can tab over the “Yes/No/Not Set” buttons. Pressing Enter while 
tabbed on a button will be the same as if you clicked on it with your mouse.
CDR Partitioning
Partitioning enables tables to be subdivided into smaller manageable pieces and each small piece 
is called a “partition” which can be safely archived. Users can see reports in GUI Home > Reports > 
Archived reports and download archived files.
Store Unanswered CDRs
An option to exclude unanswered CDR records from a report. This option can be found under 
Extension > Ring Groups > Store Unanswered CDRs.
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Mobile Applications and Queue Calls
If there is a mobile application registered on an extension in the queue and when a call is received 
from the queue, the mobile application will not be awakened via the push service.
Toggle directly to Advanced options screen
On Tenants/Servers Edit there is a new option called “Show advanced options by Default”. It is 
available on Master tenant and per Tenant, meaning that if the option is not set on Tenant the value 
set on Master Tenant will be used. If you set the option to “Yes” then the “Show Advanced Options” 
on pages will be automatically clicked and you need to confirm that everything is the same as if you 
clicked the option yourself.
Custom statuses in IP PBX
So, on IP PBX there would be a page where Admin could see a list of custom statuses, add new status, 
modify or delete old statuses. Each custom status has it’s corresponding state type (Dropdown with 
4 possible values) and status message (Text field which must not be empty). Also there should not 
be 2 custom statuses with the same message.



REMOVED FEATURES
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Sounds and Music on Hold: Sounds download / upload / conversion via Sound Converter
Easily upload, download and convert sound files from IP PBX web interface or with IP PBX Sound 
Converter desktop app. This has been replaced with an in browser sound converter wizard.
CRM Integration: Zoho
Removed support for Zoho API v1.
Agent greeting
Access code *302 disabled, do not allow agent greeting on MT.
Removed option “On DID save update ES/CID/Trunks”
MT: Removed option “On DID save update ES/CID/Trunks”.
Static Member login
Static member login is not part of CC, as we enforce using agents only.
Queue Statistics
All reporting that was strictly related agent is moved to Agent statistics section.
Scheduled Queue Reports
Extended to support Queue, Agent, Dialer statistics.
Queue Monitoring
Redesigned and moved from monitor section to queues page. Possibility to monitor per queue with 
more detailed informations.





 UNIFIED 
COMMUNICATIONS
Gain the advantage over your competition by 
combining Audio Conference, Instant Messaging, 
Video Call, Fax, Presence, Screen Pop, and more… 
all from one single interface!




